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Chapter 1: Installation Prerequisites for Windows

This document describes the steps necessary to correctly install and configure all ANSYS, Inc. products
on Windows platforms for Release 16.2. These products include:

• ANSYS Structural Mechanics

– ANSYS Mechanical Products (includes ANSYS Mechanical and Mechanical APDL)

– ANSYS Customization Files for User Programmable Features

• ANSYS Explicit Dynamics

– ANSYS Autodyn

– ANSYS LS-DYNA

• ANSYS Fluid Dynamics

– ANSYS CFX (includes ANSYS CFD-Post)

– ANSYS Fluent (includes ANSYS CFD-Post)

– ANSYS TurboGrid

– ANSYS Polyflow (includes ANSYS CFD-Post)

– ANSYS CFD-Post only

• ANSYS ICEM CFD

• ANSYS Offshore

– ANSYS Aqwa

• ANSYS Additional Tools

– ANSYS Icepak (includes ANSYS CFD-Post)

– Remote Solve Manager Standalone Services

• ANSYS PDM Interfaces

– Teamcenter

• ANSYS Geometry Interfaces

– AutoCAD

– ACIS
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– CATIA, Version 4

– CATIA, Version 5

– CATIA, Version 6

– Creo Elements/Direct Modeling

– Autodesk Inventor

– JTOpen

– NX

– Parasolid

– Creo Parametric

– Solid Edge

– SolidWorks

Note

ANSYS Workbench and ANSYS EKM Desktop are installed by default as product components
to most ANSYS, Inc. products. ANSYS Workbench is not installed as part of the products under
ANSYS Additional Tools, nor with the CFD-Post only option. ANSYS Workbench includes the
following applications:

• The Mechanical Application

• DesignModeler

• Design Exploration

• Meshing

• Remote Solve Manager

• Fluent Meshing

• FE Modeler

• EKM Client

Because some of these applications can be run as standalone applications without ANSYS
Workbench, you will see some but not all of these listed separately as options when you
uninstall. In such cases, you will need to select those options in order to uninstall those
components.

Where supported, IGES and STEP Geometry Interfaces will be installed.

Some procedures apply only to specific products and are so noted.
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Important Notice

If you want to run multiple releases of ANSYS, Inc. software, you MUST install them chronologically (i.e.,
Release 16.1 followed by Release 16.2). If you install an earlier release after installing Release 16.2, you
will encounter licensing issues that may prevent you from running any products/releases. If you need
to install an earlier release after you have already installed Release 16.2, you MUST uninstall Release
16.2, then re-install the releases in order.

1.1. System Prerequisites

ANSYS 16.2 is supported on the following Windows platforms and operating system levels. For up-to-
date information on hardware platforms or operating systems that have been certified, go to http://
www.ansys.com/Support/Platform+Support. (This URL is case-sensitive.)

Table 1.1:  Supported Windows Platforms

AvailabilityPlatform architecture
(directory name)

Operating SystemProcessor

Download, USBwinx64Windows 7, Windows 8.1, Microsoft
Windows HPC Server 2008 R2 [1],
Windows Server 2012 R2 [1]

x64 (64-bit)

1. Microsoft Windows HPC Server 2008 R2 and Windows Server 2012 R2 are supported only for select
solvers for parallel high performance execution. Any users running on Microsoft Windows HPC Server
2008 R2 or Windows Server 2012 R2 as non-admin should be a member of the HPC Users Group in the
configuration panel of the HPC Cluster Manager.

For detailed and current support information, see the Platform Support section of the ANSYS, Inc.
website (www.ansys.com).

Note

Home editions of Windows operating systems are not supported.

Supported Platforms for High Performance Computing Please see the discussions on Configuring
Distributed ANSYS and Configuring ANSYS CFX Parallel later in this guide for detailed information on
supported platforms for distributed computing.

Table 1.2:  Supported Products by Platform

Windows
Server 2012

Microsoft
Windows

HPC Server
2008

Windows
64-bit

Product

√ANSYS Workbench
data-integrated and
native applications

Standalone Solvers and Applications

22√Mechanical APDL

22√CFX
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Windows
Server 2012

Microsoft
Windows

HPC Server
2008

Windows
64-bit

Product

√TurboGrid

√ICEM CFD

√Autodyn

√LS-DYNA

22√Fluent

√Aqwa

√Polyflow

22√Icepak

√EKM Server

1. Supported as a 32-bit application

2. Solver only support

1.1.1. CAD Support

The following CAD and auxiliary programs are supported on the indicated products and platforms
(where the CAD product is supported on the noted platforms). Products are:

A = Mechanical APDL
W = ANSYS Workbench
I = ANSYS ICEM CFD standalone (some CAD systems may require the integrated ANSYS Work-
bench Reader)

Table 1.3:  CAD Support by Platform

Windows 8.1
64–bit 6

Windows 7 64–bitProduct

A, W, IA, W, ICATIA 4.2.4

A, W, IA, W, ICATIA V5–6R2014

W, I11W, ICATIA V5 (CADNexus CAPRI CAE Gateway V3.20.0) V5–6R2012,
V5–6R2013, V5–6R2014

W, IW, ICATIA V6 R2013x

A, W, IA, W, IParasolid 26.0 10

A, W, ICreo Parametric Wildfire 5.0 2, 3

W, IA, W, ICreo Parametric 2.0 12

A , W, IA, W, ICreo Parametric 3.0

A, W, IA, W, IACIS 25 1

A, W, IA, W, INX 8.5

A, W, IA, W, INX 9.0

A, W, IA, W, INX 10.0

W, I 13W, ISolidWorks 2014
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Windows 8.1
64–bit 6

Windows 7 64–bitProduct

W, IW, ISolidWorks 2015

W, ISolid Edge ST6

W, IW, ISolid Edge ST7

W, I 7W, IAutodesk Inventor 2014

W, IW, IAutodesk Inventor 2015

W, IAutoCAD 2013

W, I 14W, IAutoCAD 2014

A, W, IA, W, IIGES

W, IW, IJT 9.5

W, IW, ISTEP AP203, AP214

W, I 8W, ICreo Elements/Direct Modeling 18.1

W, IW, ICreo Elements/Direct Modeling 19.0

W 15Teamcenter Unified Architecture 9.1 (2– & 4–tier) with NX
8.5.2 MP1 and NX 9.0

WTeamcenter Unified Architecture 9.1.3 (2– & 4–tier) with NX
8.0 (8.0.2 or higher), NX 8.5.2 MP1 & NX 9.0

WTeamcenter Unified Architecture 10.1.0.1 (2– & 4–tier) with
NX 8.5.2 MP1 & NX 9.0

IIGEMS

IIIDI MS8/9

IIRhinoceros

1. For ICEM CFD standalone, ACIS 18.0.1 is the supported version for all platforms.

2. Requires Pro/ENGINEER 5 Build Date M020 or higher for Windows 7.

3. Pro/ENGINEER Wildfire 5 is also named Creo Elements/Pro 5.0.

4. MAPDL supports 5.1 by default, but 5.2 is also supported if the IOPTN command is used.

5. IGES Versions 4.0, 5.2, and 5.3 are supported.

6. Professional and Enterprise

7. Requires Autodesk Inventor 2014 SP1.

8. Requires CoCreate 18.1 M060 or later.

9. Requires AutoCAD 2013 SP2.

10. For ICEM CFD direct interface, Parasolid 24.0 is the supported version on all platforms.

11. Requires CATIA V5–6R2014.

12. Requires Creo Parametric 2.0 M100.
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13. Requires SolidWorks 2014 SP1.

14. Requires Installation of Autodesk’s Model Documentation Hotfix.

15. Requires patch 9.1.3 with NX 8.5.2 MP1 and NX 9.0.

Note

View the latest supported CAD packages at ansys.com> Support> Platform Support>
Certified and Supported Computing Platforms.

1.2. Disk Space and Memory Requirements

You will need the disk space shown here for each product for installation and proper functioning. The
numbers listed here are the maximum amount of disk space you will need for each ANSYS, Inc. product.
Depending on the options selected for each product, you may require less.

Disk SpaceProduct

8.1 GBANSYS Mechanical APDL

6.3 GBANSYS Autodyn

6.5 GBANSYS LS-DYNA

6.9 GBANSYS CFX

6.2 GBANSYS TurboGrid

7.2 GBANSYS Fluent

7.2 GBANSYS Polyflow

6.0 GBANSYS Aqwa

7.0 GBANSYS ICEM CFD

7.3 GBANSYS Icepak

6.2 GBANSYS CFD Post only

1.5 GBANSYS Geometry Interfaces

1.2 GBCATIA v5

95 MBCATIA v6

2.2 GBANSYS Remote Solve Manager Standalone Services

2.9 GBANSYS Composite PrepPost

Product installations also require an additional 500 MB of free disk space during an installation.

Memory Requirements You must have a minimum of 8 GB of memory to run product installations;
16 or 32 GB of memory is recommended.

1.3. Software Prerequisites

You must have the following software installed on your system. Administrator privileges are required
to install these files. These software prerequisites will be installed automatically when you launch the
product installation. If you've completed an installation successfully, the executables are also located
under the \v162\prereq directory should you need to manually install them at a later date. Prior to
installing, you can find them in the root \prereq directory of the media/download package.
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• Microsoft .NET Framework 4.0

.NET Framework 4.0 is native on Windows 8.1 and does not require any additional patches.

.NET Framework 4.0 is required for Windows 7.

• Microsoft Visual C++ 2005 SP1 Redistributable, 2.0.50727.762

• Microsoft Visual C++ 2008 SP1 ATL Redistributable Package

• Microsoft Visual C++ 2008 Service Pack 1 Redistributable Package MFC Security Update

• Microsoft Visual C++ 2010 SP1 ATL Redistributable Package

1.4. Requirements for the GPU Accelerator in Mechanical APDL

Your system must meet the following requirements to use the GPU accelerator capability in Mechanical
APDL:

• The machine(s) being used for the simulation must contain at least one supported nVIDIA GPU card or one
Intel Xeon Phi coprocessor. The following cards are supported:

nVIDIA Tesla series (any model)
nVIDIA Quadro 6000
nVIDIA Quadro K5000
nVIDIA Quadro K6000
Intel Xeon Phi 7120
Intel Xeon Phi 5110
Intel Xeon Phi 3120

• For nVIDIA GPU cards, the driver version must be 333.11 or newer. For optimal performance on Windows,
the TCC (Tesla Compute Cluster) driver mode is recommended when using Tesla series GPU cards. Some
limitations exist when using this driver mode (e.g., no support for Windows XP). Check your GPU card doc-
umentation for more details on how to set this driver mode and the existing limitations.

• For Intel Xeon Phi coprocessors, the driver version must be “MPSS 3.4” or newer.

Note

On Windows, the use of Remote Desktop may disable the use of a GPU device. Launching
Mechanical APDL through the ANSYS Remote Solve Manager (RSM) when RSM is installed
as a service may also disable the use of a GPU. In these two scenarios, the GPU accelerator
capability cannot be used. Using the TCC (Tesla Compute Cluster) driver mode, if applicable,
can circumvent this restriction.

1.5. Additional Hardware and Software Requirements

•  Intel 64 / AMD64 system with the correct operating system version installed

• 8 GB of RAM

• 128 GB free on the hard drive is recommended
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• Certified graphics card with the latest drivers, compatible with the supported operating systems, capable
of supporting 1024x768 High Color, and a 17-inch monitor compatible with this type of graphics card. We
recommend using certified graphics card from the Nvidia Quadro FX or AMD FirePro line.

Note

Use of Ultra High Definition (4K) graphics cards cause a number of cosmetic display
issues (including enlarged or reduced text and incorrect positioning of option labels).
These issues do not affect the functionality of the installation program.

ANSYS CFX products and ANSYS TurboGrid require at least 24-bit color and that antialiasing on your
graphics card be disabled. How you determine whether antialiasing is enabled and how to disable
the feature varies according to the graphics card you have. Please contact your system administrator
or refer to your system documentation for detailed instructions on changing antialiasing settings.

Note

Some combinations of graphics card type, operating system, and MPEG resolution fail to
play MPEGs properly. You may be able to get normal playback results simply by changing
the MPEG settings. Alternatively, you can upgrade your graphics card.

• For laptop systems, ANSYS Workbench requires the latest graphics drivers.

• Microsoft Mouse or a mouse compatible with the supported operating systems; ANSYS CFX-Pre and ANSYS
CFD-Post require a three-button mouse.

• If you use a 3Dconnexion product, ensure that you have the latest version of the drivers installed.

• Approximately twice as much swap space as memory. The amount of memory swap space on the system
may limit the size of the ANSYS model that can be created and/or solved.

• TCP/IP for the license manager (see the ANSYS, Inc. Licensing Guide for more information on TCP/IP).

Although TCP/IP is included as part of the operating system, it may not be installed by default. When
TCP/IP is installed, it must be bound to a network adapter. On machines that are connected to an
internal network, TCP/IP must be bound to a network card such as an Ethernet adapter. The vast
majority of systems using TCP/IP will fall into this category. On machines that connect to the internet
or corporate intranet through a modem, TCP/IP can be bound to the Remote Access Service. Also,
the Autodial option of the Internet Options must be disabled so that the machine does not attempt
to connect to the Internet every time ANSYS is run. See the ANSYS, Inc. Licensing Guide for more in-
formation.

• Microsoft Internet Explorer (IE) 9 or greater is recommended for proper operation of ANSYS Workbench.
Once the correct version of IE is installed, it does not have to be your default Internet browser. After install-
ation, simply run your preferred browser and reestablish it as the default.

• PDF reader software is required to read the installation guides and other user documentation.

To access our help system videos, ANSYS recommends that you set Windows Media Player as your
default. Note--The default media player for Windows 8.1 is defined as Video; please change this setting
to Windows Media Player.
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1.5.1. ANSYS AIM Requirements

For basic usage and simple models, a workstation-class 3D-capable graphics card with at least 256 MB
of memory that supports OpenGL version 3.3 or higher, as noted below, is needed to successfully run
AIM.

To analyze larger models, use a recent NVidia Quadro or AMD FirePro card, including:

ATI MobileATI
NVidia
Mobile

NVidia

FirePro
Mx9xx

FirePro
Vx800

Quadro
x600M

Quadro FX
x700

FirePro
Mx000

FirePro
Vx900

Quadro
x700M

Quadro FX
x800

FirePro Wx
Quadro
x800M

Quadro x000

FirePro Sx
Quadro
x000M

Quadro Kxxx

Quadro
kx000M

Quadro Kxxxx

Quadro
kx100M

Note on Intel Graphics Cards: Use of integrated Intel graphics cards is not recommended. These cards
are typically found in lightweight laptops or notebooks, and are known to have OpenGL incompatibil-
ities resulting in display issues in AIM. Examples are Intel HD 3000 and 4000 series cards.

Note on Hybrid Graphics: If your graphics system supports two graphics chips, one integrated and
one dedicated (example is NVidia Optimus), please ensure that the dedicated graphics chip is used
when launching AIM. Instructions on how to do this can typically be found on graphics card vendor's
web site.

1.5.2. 3Dconnexion Product Support

Only the Mechanical APDL, ANSYS Meshing, DesignModeler, Mechanical, ANSYS ICEM CFD, and CFD-
Post applications have been tested for manipulating the model (turning, zooming, panning, etc.) with
the 3Dconnexion products. While these 3Dconnexion products do provide significantly enhanced 3D
control over viewing the model, they do not function as a mouse replacement and selection operations
still require a mouse.

To use a 3Dconnexion product with the listed products, you must download and install the appropriate
Microsoft Windows® driver for your version of Windows. Please refer to http://www.3dconnexion.com
for more information on using Space products and to download the appropriate drivers.

1.6. Third-Party Software and other Security Considerations

The following third-party products are used as part of the installation process. In order for the installation
to work properly, you must allow access to these products.

9
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Executable NameProduct Name

tclsh.exeTcl

want.exeTk

perl.exePerl

7z.exe7zip

.netMicrosoft .NET
Framework
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Chapter 2: Platform Details

2.1. User Account Control (UAC)

Windows 7 and Windows 8.1

Windows 7 and Windows 8.1 use a feature called User Account Control (UAC) to control privileges and
automatically reduce the potential of security breaches in the operation system. However, UAC limits
your accessibility to system areas and can cause unpredictable behavior in ANSYS, Inc. products.

ANSYS, Inc. requires that you have full administrative privileges when installing any software on Microsoft
Windows 7 or Windows 8.1. Non-administrative accounts do not usually have the permissions required
to access system areas that installation programs often need to modify. “Full administrative privileges”
means that you are running as administrator with UAC turned off, or you are running as administrator
with UAC turned on and Run as Administrator selected. Because of changes to the UAC functionality,
it is necessary that you right-click and select Run as Administrator from the context menu when in-
stalling to Windows 8.1.

Recommended Installation Options for Windows 7:

• UAC turned off and install as full administrator (preferred method)

• UAC turned on and install with full administrative privileges (using Run as Administrator from the context
menu)

Note

If you are running with UAC on, even if you have administrative privileges, you will have
limited account control unless you specifically choose Run as Administrator.

Recommended Installation Options for Windows 8.1:

• UAC turned off and install with full administrative privileges (using Run as Administrator from the context
menu)

When installing ANSYS, Inc. products, we strongly recommend that you use the recommended options
above. If UAC is enabled, we recommend that you turn UAC off before installing ANSYS, Inc. products,
and then turn it back on when finished installing. You must be an administrative user in order to disable
UAC.

Follow the instructions for your operating system for disabling UAC.

Once you have installed your applications, you can enable UAC again.
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Installing with UAC On

If you cannot disable UAC and need to install with UAC on, you must run all applications, including the
installation setup, as an administrator. Otherwise, the files may be written to AppData\Local\Vir-
tualStore\<path> (or similar) rather than directly to <path>, if <path> is a protected directory
(such as C:\Program Files). As a result, some applications and utilities may behave unpredictably.

If you cannot disable UAC, you should perform the following functions:

For Windows 7:

• Always run ANSLIC_ADMIN, the File Association utility, and the CAD Configuration Manager by selecting
the utility or application from the Start menu and right-mouse clicking and selecting Run as Administrator.

• Set your Start menu shortcuts to always run as administrator with the following procedure (or similar):

1. Right-click the shortcut you wish to modify and select Properties.

2. From the Properties dialog box, click Advanced on the Shortcut tab.

3. Select Run as administrator and click OK.

4. Click OK.

Refer to your operating system documentation or visit www.microsoft.com for more instructions on
setting Run as Administrator at various levels within the operating system.

For Windows 8.1:

• Always run ANSLIC_ADMIN, the File Association utility, and the CAD Configuration Manager by
selecting the utility or application from the Start menu and right-mouse clicking and selecting Run as
Administrator.

• Set your Start menu shortcuts to always run as administrator with the following procedure (or similar):

1. Right-click the shortcut you wish to modify and select Open File Location from the options located
at the bottom of your screen.

2. Right-click the shortcut file that is displayed and click Properties from the menu.

3. From the Properties dialog box, click Advanced on the Shortcut tab.

4. Select Run as administrator and click OK.

5. Click OK.

Notes about UAC

When installing ANSYS, Inc. products, including the license manager, on Windows 7 and Windows 8.1
machines, you need to be aware of several factors involving User Access Control (UAC):

You should install the ANSYS, Inc. License Manager using the same permissions as you used to install
the product.
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If you install both the product and the license manager with full administrative privileges, the product
and licensing installation and configuration will proceed as normal.

If you install as an administrative user with UAC turned on, you may encounter unpredictable behavior
with both the product and license manager installations and subsequent behavior. As an administrator,
you should choose to install and run applications with full administrative privileges to avoid any unpre-
dictable situations. We strongly recommend against running with UAC on and not selecting Run as
Administrator. These situations are described below.

1. If you have UAC turned on and you do not install (and run) with full administrative privileges, be aware
that files may be written to and read from the %localappdata%\VirtualStore\ location (in the case
of licensing, to %localappdata%\VirtualStore\Program Files\ANSYS Inc\Shared
Files\Licensing) instead of to the <os drive>.

In this situation, ANSLIC_ADMIN settings, such as Specify the License Server Machine, will indicate
that files are being written to and read from <os drive>\Program Files\ANSYS Inc\Shared
Files\Licensing. Log files may behave in the same way. However, when you view the an-
syslmd.ini file located in <os drive>\Program Files\ANSYS Inc\Shared
Files\Licensing, you will not see the ANSLIC_ADMIN settings you specified.

2. To ensure that files are correctly written to and read from <os drive>\Program Files\ANSYS
Inc\Shared Files\Licensing, you should always run with full administrative privileges by selecting
Run as Administrator.

3. If you are not running with full administrative privileges, you will not be able to use those ANSLIC_ADMIN
options that require administrative privileges, such as starting and stopping the license manager.

2.2. Utilizing CPU Hyperthreading Technology with ANSYS CFD Solvers

Hyperthreading technology uses one processor core to run more than one task at a time. ANSYS does
not recommend using hyperthreading technology in conjunction with ANSYS CFD Solvers (Fluent, CFX
and AIM Fluids). We recommend that you turn CPU hyperthreading off (default is on). A system admin-
istrator needs to reboot the system and enter the BIOS to turn the hyperthreading option off.

2.3. Compiler Requirements for Windows Systems

Table 2.1:  Compiler Requirements for All Windows Versions

AUTODYN
Compilers*

Fluent Compilers*CFX Compilers*Mechanical APDL,
ANSYS Workbench
Compilers*

Visual Studio 2010
SP1 (including the

Visual Studio 2010
SP1 (including the
MS C++ compiler)

Visual Studio 2010
SP1 (including the
MS C++ compiler)

Visual Studio 2010 SP1
(including the MS C++
compiler) and Intel MS C++ compiler)

and IntelFORTRAN 14.0.3
compilers

and Intel
FORTRAN 14.0.3
compilers

FORTRAN 14.0.3
compilers

* Compilers are required only if you will be using User Programmable Features (UPF), User Defined
Functions (UDF), or other customization options.
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2.4. Select Your Installation

The next step is to select your installation type. Please select the option below that matches your install-
ation.

• Installing the ANSYS Software for a Stand-alone Windows System (p. 15)

• Installing the ANSYS Products and the License Manager on Different Windows Machines (p. 25)
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Chapter 3: Installing the ANSYS Software for a Stand-alone Windows
System

This section includes the steps required for installing ANSYS, Inc. products and licensing configuration
on one Windows machine.

You can follow these instructions while actually installing the products and setting up the license
server. To do so, simply use the selections that are pertinent to you and insert your specific information
where noted.

Before You Begin

We recommend that you have the following information available before you begin this installation:

• An account on the ANSYS Customer Portal. If you do not have an account, you may register at https://sup-
port.ansys.com/portal/site/AnsysCustomerPortal to receive your own account.

• Your license file from ANSYS, Inc., saved to a temporary directory. For more information, see Registering the
License Server (p. 23).

• Open port numbers forFlexNet and ANSYS Licensing Interconnect. Defaults are 1055 and 2325, respectively.
To verify that these port numbers are available, open a command line and enter the following command:

netstat -a -p tcp

You will see a list of active ports. If 1055 and 2325 are listed, they are already in use and cannot be
used for ANSYS, Inc. licensing. In this case, you will need to specify different port numbers where in-
dicated later in this installation.

• Your local machine's hostname, to specify as the license server.

You should also verify that you are running on a supported platform. ANSYS, Inc. supports 64-bit systems
running Windows 7 and Windows 8.1.

Verify that you have sufficient disk space to download, uncompress, and install the products you will
be installing.

If you have any problems with--or questions about--the installation process, log a Service Request on
the ANSYS Customer Portal to have a Systems Support Specialist assist you.

These instructions are divided into four sections:

• Product Download/DVD Instructions: This set of instructions describes the download and extraction process.

• Product Installation with Client Licensing: This set of instructions describes the product installation, including
the client licensing portion.

• License Manager Installation: This set of instructions describes the license manager installation.
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• Post-Installation Procedures for All Products: This is a set of instructions that describes any configuration
steps that may be required for the various products.

For this installation, both the product and the license manager will be installed on the same machine.
You must complete both the client licensing portion and the license manager installation in order to run
ANSYS, Inc. products.

3.1. Downloading the Installation Files

To download the installation files from our website, you will need to have a current technical support
agreement.

Depending on the product/platform combination(s) you choose, you may need to download multiple
files.

1. From the Customer Portal, https://support.ansys.com/portal/site/AnsysCustomerPortal, click Downloads
> Current Release.

Step 1 of the ANSYS Download Center Select Full Products page is displayed.

2. Select your installation operating system (Windows x64 or Linux x64).

3. Select the type of files you wish to download:

• Primary Packages: Individual full packages for the primary ANSYS products.

• ISO Images: ISO images for the DVD installation.

4. Click the appropriate download option.

5. Select your desired download directory and click Save.

6. Repeat this process for each download file.

7. To download Add-On Packages, Tools or Academic Packages, click the + to the right of the appropriate
product group title to display the download options and download as required.

8. After all downloads have been completed, uncompress each package using standard uncompression
utilities for your specific platform. We strongly recommend that you extract the files into new, temporary
directories.

9. Begin the product installation as described in Installing ANSYS, Inc. Products (p. 17).

3.1.1. Installing from a USB Drive

To install ANSYS, Inc. products from a USB drive, insert the USB drive into a USB slot on your computer.
Locate and right-click the setup.exe file stored at the root level of the USB and select Run as adminis-
trator. Continue with the steps described in Installing ANSYS, Inc. Products (p. 17).

3.1.2. Installing from a DVD

To install ANSYS, Inc. products from a DVD, place the DVD in your DVD drive. If autorun is enabled, the
installation will begin automatically. If autorun is disabled, locate and right-click the setup.exe file
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contained on the DVD and select Run as administrator. Continue with the steps described in Installing
ANSYS, Inc. Products (p. 17).

You will be prompted to change DVDs during the installation. Please make sure you have all installation
DVDs before beginning the installation.

3.2. Installing ANSYS, Inc. Products

This section explains how to install ANSYS, Inc. products.

Note

ANSYS requires users to install all products by using the right-click option Run as ad-
ministrator.

.

3.2.1. Product Installation with Client Licensing

To install ANSYS, Inc. products with client licensing, follow the steps below.

Note

You must also install the ANSYS, Inc. License Manager on at least one server machine in order
to run ANSYS, Inc. products. See ANSYS License Manager Installation (p. 21) for license
manager installation instructions.

1. Save all data and close all Windows applications before continuing.

2. If you downloaded the installation files or if you are installing from a DVD or USB with autorun disabled,
browse to the location of the setup.exe file. Right-click the setup.exe file and select Run as admin-
istrator.

The ANSYS, Inc. Installation Launcher appears.
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From the options on the left side of the launcher you can install ANSYS products, ANSYS EKM
Server, MPI for ANSYS Parallel Processing, and the ANSYS License Manager. You can access the in-
stallation guide for the ANSYS EKM Server from the Downloads page on the Customer Portal. The
MPI for ANSYS Parallel Processing installation steps are displayed when you click the  Install MPI
for ANSYS Parallel Processing link.

The ANSYS, Inc. Quick Start Installation Guide, ANSYS, Inc. Quick Start Licensing Guide, System Re-
quirements Guide and complete Installation Help Guide can be accessed through the options located
along the bottom of the launcher.

3. Select the language you want to use from the drop-down menu in the upper right corner. English is the
default.

4. Click the Install ANSYS Products option.

The license agreement appears.

5. Read the agreement, and if you agree to the terms and conditions, select I Agree. Click Next.

6. The directory where you want to install the ANSYS, Inc. products is shown in the Install Directory field.
You can install the products into any directory you want, but you must have write permissions to the
directory you choose. The default is C:\Program Files\ANSYS Inc. We recommend using the default
directory.

Note

You must install all ANSYS, Inc. products into the same location. Installing products
into different locations can cause product components to fail. If you choose an install
directory via the Browse feature, the installation will automatically append \ANSYS
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Inc\ to the chosen directory. The installation path can have a maximum of 100
characters, except on AUTODYN, which has a maximum of 40 characters.

• Leave the Associate file extensions with ANSYS products checkbox marked. This allows you to
double-click files from Windows Explorer to launch the various products.

• Choose Disable ANSYS RSS Feed to disable automatic internet feeds to ANSYS, Inc. products.

Click Next.

7. If this is a first time installation, you are prompted to enter your license server specification. If you already
have an existing license server specification file, you will not see this window and proceed directly to the
next step.

Enter your ANSYS Licensing Interconnect port number and your ANSYS FlexNet port number. Defaults
are provided and will work in most cases. You may need to check with your IT department to
confirm that the default port numbers are valid or to get different port numbers if necessary.

Specify the hostname for your license server machine(s).

Click Next.

8. All products available in the installation package(s) you downloaded are listed.

The installation program attempts to query your license server to pre-select your installation options.
If the query is successful, the following message is displayed:

Your installation options were pre-selected based upon information from your license server.

If the installation program was unable to query your license server, this message is not displayed
and the default installation options are selected.

You can select or deselect any combination of products. ANSYS Workbench is automatically installed
with most ANSYS, Inc. products; there is no individual product selection for ANSYS Workbench.

If you select AutoCAD, Catia V5, Inventor, NX, Creo Parametric, Solid Edge, or SolidWorks, you will
have additional installation steps. Please see Specifying CAD Configurations (p. 20).

By default, the Install Documentation option is enabled (checked). When enabled, help document-
ation is included as part of the installation process for all products selected. No help documentation
is included with the installation if this box is disabled (unchecked).

You will also see an estimate of the disk space required to install all of the selected components,
and the disk space you have available. The actual amount of disk space required may be less, but
if you choose to run the installation with insufficient disk space available, we strongly recommend
that you review the log files at the end of the installation to verify that all products were installed
correctly. Installation log files are written to the installation directory.

Note

On a first time installation, if you chose to install any ANSYS Geometry Interfaces, en-
sure that you have also selected at least one ANSYS, Inc. product as part of the in-
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stallation. Installing an ANSYS Geometry Interface without an underlying ANSYS,
Inc. product on a first time installation may cause installation errors.

Select/deselect the products you want to install and click Next.

The dates on the licensing files being installed are compared to any that may already exist on your
machine. (This may take a few moments.)

9. A summary of the selected installation data appears. Review the information carefully, and if correct, click
Next to continue the installation.

10. The installation progress screen displays a status bar towards the bottom of the installation window. This
status bar tracks the percentage of packages that have been installed on your computer. Depending on
the number of products you have selected, the installation time required could be lengthy. You will not
be able to interrupt the installation process. Please be patient while the installation completes.

Note

Clicking the View Details Progress Log button opens a second window that displays
the name of each product package as it is uncompressed and installed.

The installation program will first check your system to determine if you have the necessary pre-
requisites. If the prerequisites are not already on your system, the prerequisites will be installed
automatically. You may be asked to run the necessary files (such as the .NET exe), or to reboot your
machine, depending on your existing machine configuration. If you are asked, you will need to
reboot in order to complete the prerequisite installation successfully.

Click Next to continue the installation.

11. The product installation window reappears with a message noting that the installation is complete. A
Launch Survey Upon Exiting option is included here. Clicking Exit while the Launch Survey Upon Ex-
iting is enabled causes your default browser to open, displaying the product survey. Disabling (un-
checking) the Launch Survey Upon Exiting option and then clicking Exit skips the survey.

Note

If prerequisite components necessary for the installation of the ANSYS products
were installed, the following message may be displayed:

A system restart is required before using any ANSYS Products.

The ANSYS, Inc. Installation Launcher appears. For this stand-alone installation, you must complete
the License Manager installation (next) to run ANSYS, Inc. products.

3.2.1.1. Specifying CAD Configurations

Creo Parametric

1. If you selected Creo Parametric, you will have to choose which Creo Parametric product to configure. You
can choose the Reader (non-associative), Workbench Associative Interface (requires that the CAD product
be installed), or skip and configure later (using the CAD Configuration Manager).

Release 16.2 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.20

Installing the ANSYS Software for a Stand-alone Windows System



2. If you choose the Workbench Associative Interface, you may need to specify the Creo Parametric language,
the Creo Parametric command, and the full Creo Parametric installation path (C:\Program
Files\PTC\Creo 1.0\Parametric by default) for an existing Creo Parametric installation. Click
Next.

NX

1. If you selected NX, you will have to choose which NX product to configure. You can choose the Reader
(non-associative), Workbench Associative Interface (requires that the CAD product be installed), or skip
and configure later (using the CAD Configuration Manager).

2. If you choose the Workbench Associative Interface and the UGII environment variables were not set, you
may need to specify the NX installation path for an existing NX installation. If you are an administrative
user, a file required to load the NX plug-in is placed in the administrative user's Application Data folder
by default, which may not be accessible by other, non-administrative users. To allow non-administrative
users to run, you will need to define the environment variable UGII_CUSTOM_DIRECTORY_FILE prior
to installation and specify a location where other users have read access. Alternatively, you can run the
CAD Configuration Manager after the installation and provide an updated location for the NX Custom
Directory File Path under the NX tab.

3. If you selected the ANSYS ICEM CFD NX Interface product but not the NX Geometry Interface product on
the product selection screen, you may need to specify the NX installation path or choose to skip config-
uring NX and use the CAD Configuration Manager to configure later.

CATIA v5

• If you selected CATIA v5 and any product that includes ANSYS Workbench, you will be required to select
the appropriate CAD reader/plugin for ANSYS Workbench. You can choose to configure the Reader,
CADNexus CAPRI CAE Gateway, or skip and configure later (using the CAD Configuration Manager).

SolidWorks and Autodesk Inventor

• If you selected Inventor and/or SolidWorks as one of your CAD products, you will have to choose which
Inventor and/or SolidWorks product to configure. You can choose the Reader (non-associative), Workbench
Associative Interface (requires that the CAD product be installed), or skip and configure later (using the
CAD Configuration Manager).

If you have not yet installed these programs, or do not know the requested information, you can choose
to skip these configuration steps. If you skip these steps, you will need to manually configure these
CAD interfaces using the CAD Configuration Manager before you can successfully import models into
Mechanical APDL, ANSYS Workbench, or ICEM CFD. You can access the CAD Configuration Manager
in Windows 7 (Start > All Programs > ANSYS 16.2 > Utilities > CAD Configuration Manager 16.2)
and in Windows 8.1 (Right-click the Start Screen> All apps> ANSYS 16.2 > CAD Configuration
Manager 16.2). See Configuring CAD Products (p. 53) for more information on using the CAD Config-
uration Manager.

3.2.2. ANSYS License Manager Installation

Follow the instructions below to install and configure the ANSYS License Manager on your local Windows
machine. You must be an administrative user to install the ANSYS License Manager on Windows. The
License Manager controls access to the ANSYS, Inc. products you have purchased. You must complete
the License Manager installation to run ANSYS, Inc. products.

1. If the Installation Launcher is not open, right-click the setup.exe file and select Run as administrator.
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2. Select Install ANSYS License Manager.

If you downloaded only the license manager installation, right-click setupLM.exe and select Run
as administrator.

3. The installation launcher appears.

4. You will be notified that the license manager, if running, will be shut down. Click OK.

5. The License Agreement screen appears. Read the license agreement, and if you agree, click I Agree to
accept the terms and click Next. You must select I Agree to continue with the installation.

6. Specify the installation directory and click Next to continue.. You can accept the default or specify an al-
ternate path and the directory name where the license manager is to be installed. The installation directory
is set to <OS_Drive>\Program Files\ANSYS Inc by default. You must have administrative priv-
ileges for the directory you specify. In addition, the directory:

• must be a local directory

• must be a local, fixed-media drive

• cannot be a UNC or relative path

• cannot be a short (8.3) file name format path

• cannot be a symbolic link or junction

• cannot use wide character names/paths

Note

You are unable to change the installation directory for a computer that currently contains
an instance of the ANSYS, Inc. License Manager or ANSYS Electromagnetics License
Manager. To change the installation directory location, you must first uninstall any pre-
vious versions of both products.

The ANSYS, Inc. License Manager is the only component available and is selected to be installed.
The amount of disk space required and the disk space available appear at the bottom of the window.
Be sure that you have sufficient space before continuing.

7. Click Next to continue.

8. A summary of the selected installation data appears. Review the information carefully, and if correct, click
Next to continue the installation.

The ANSYS License Manager is now being installed and configured on your system. After the License
Manager installation has been completed, the Launch License Management Center upon exiting
option is included on the screen. The ANSYS License Management Center is a browser-based
user interface that centralizes many of the ANSYS product licensing administrative functions. If you
do not want to launch the License Management Center, uncheck the Launch License Management
Center upon exiting option.

9. Click Exit to close the License Manager Installation screen.
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10. When the license manager installation is complete, click Exit. A new Start Menu item named ANSYS, Inc.
License Manager will be created automatically. It will include selections for the License Management
Center, the ANSYS, Inc. Licensing Guide, the FlexNet License Administration Guide and the ANSLIC_ADMIN
utility.

3.2.2.1. Registering the License Server

If you are a new user who has not received a license file for your server or if you add or change a license
server machine, follow this procedure to register your license server information. See the ANSYS, Inc.
Licensing Guide for more information on selecting license servers (Selecting License Server Machines)
and on using the ANSLIC_ADMIN server utility.

1. Use the Register License Server Machine Information option of the ANSLIC_ADMIN server utility to re-
gister license server information on each license server.

2. Select OK and Create File to save this information to a file named licserver.info by default.

3. Return the resulting licserver.info file to your ANSYS sales representative. ANSYS, Inc. or your sales
representative will then supply you with your license keys. This file is located in Program Files\ANSYS
Inc\Shared Files\Licensing\licserver.info by default.

4. Use the Run the License Wizard option of the ANSLIC_ADMIN server utility to install your license file and
start the license manager.

After completing the installation process, please refer to Post-Installation Instructions (p. 37)
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Chapter 4: Installing the ANSYS Products and the License Manager
on Different Windows Machines

This section describes installing ANSYS, Inc. products on one Windows machine and installing the ANSYS,
Inc. License Manager on a different Windows machine that will act as a license server.

You can follow these instructions while actually installing the products and setting up the license
server. To do so, simply use the selections that are pertinent to you and insert your specific information
where noted.

Before You Begin

We recommend that you have the following information available before you begin this installation:

• An account on the ANSYS Customer Portal. If you do not have an account, you may register at https://sup-
port.ansys.com/portal/site/AnsysCustomerPortal to receive your own account.

• Your license file from ANSYS, Inc., saved to a temporary directory. For more information, see Registering the
License Server (p. 35).

• Open port numbers for FlexNet and ANSYS Licensing Interconnect on your license server machine. Defaults
are 1055 and 2325, respectively. To verify that these port numbers are available, open a command line on
the server machine and enter the following command:

netstat -a -p tcp

You will see a list of active ports. If 1055 and 2325 are listed, they are already in use and cannot be
used for ANSYS, Inc. licensing. In this case, you will need to specify different port numbers where in-
dicated later in this tutorial.

• The hostname of the machine that will act as a license server.

You should also verify that you are running on a supported platform. ANSYS, Inc. supports 64-bit systems
running Windows 7, and Windows 8.1.

Verify that you have sufficient disk space to download, uncompress, and install the products you will
be installing.

For network installations, the same UNC paths or mapped drive letters must be used on the server and
all client computers. Failure to use matching UNC paths or mapped letter drives can cause server
communication issues or loss of product functionality.

If you have any problems with--or questions about--the installation process, log a Service Request on
the ANSYS Customer Portal to have a Systems Support Specialist assist you.

This installation is divided into four sets of instructions:

• Product Download/DVD Instructions: This set of instructions describes the download and extraction process.
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• Product Installation with Client Licensing: This set of instructions describes the product installation, including
the client licensing portion.

• License Manager Installation: This set of instructions describes the license manager installation.

• Post-Installation Procedures for All Products: This is a set of instructions that describes any configuration
steps that may be required for the various products.

For this procedure, the product and the license manager will be installed on separate Windows machines.
You must complete both the client licensing portion and the license manager installation in order to run
ANSYS, Inc. products.

4.1. Downloading the Installation Files

To download the installation files from our website, you will need to have a current technical support
agreement.

Depending on the product/platform combination(s) you choose, you may need to download multiple
files.

1. From the Customer Portal, https://support.ansys.com/portal/site/AnsysCustomerPortal, click Downloads
> Current Release.

Step 1 of the ANSYS Download Center Select Full Products page is displayed.

2. Select your installation operating system (Windows x64 or Linux x64).

3. Select the type of files you wish to download:

• Primary Packages: Individual full packages for the primary ANSYS products.

• ISO Images: ISO images for the DVD installation.

4. Click the appropriate download option.

5. Select your desired download directory and click Save.

6. Repeat this process for each download file.

7. To download Add-On Packages, Tools or Academic Packages, click the + to the right of the appropriate
product group title to display the download options and download as required.

8. After all downloads have been completed, uncompress each package using standard uncompression
utilities for your specific platform. We strongly recommend that you extract the files into new, temporary
directories.

9. Begin the product installation as described in Installing ANSYS, Inc. Products (p. 27)

4.1.1. Installing from a USB Drive

To install ANSYS, Inc. products from a USB drive, insert the USB drive into a USB slot on your computer.
Locate and right-click the setup.exe file stored at the root level of the USB and select Run as adminis-
trator. Continue with the steps described in Installing ANSYS, Inc. Products (p. 27).
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4.1.2. Installing from a DVD

To install ANSYS, Inc. products from a DVD, place the DVD in your DVD drive. If autorun is enabled, the
installation will begin automatically. If autorun is disabled, locate and right-click the setup.exe file
contained on the DVD and select Run as administrator. Continue with the steps in Installing ANSYS,
Inc. Products (p. 27).

If you are installing from media, you will be prompted to change DVDs during the installation. Please
make sure you have all installation DVDs before beginning the installation.

4.2. Installing ANSYS, Inc. Products

This section explains how to install ANSYS, Inc. products.

Note

ANSYS requires users to install all products by using the right-click option Run as ad-
ministrator.

4.2.1. Product Installation with Client Licensing

To install ANSYS, Inc. products, including client licensing, follow the steps below.

Note

You must also install the ANSYS, Inc. License Manager on at least one server machine in order
to run ANSYS, Inc. products. See ANSYS License Manager Installation (p. 34) for license
manager installation instructions.

1. Save all data and close all Windows applications before continuing.

2. If you downloaded the installation files or if you are installing from a DVD or USB with autorun disabled,
navigate to the location of the setup.exe file. Right-click the setup.exe file and select Run as admin-
istrator.

The ANSYS, Inc. Installation Launcher appears.
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From the options on the left side of the launcher you can install ANSYS products, ANSYS EKM
Server, MPI for ANSYS Parallel Processing, and the ANSYS License Manager. You can access the in-
stallation guide for the ANSYS EKM Server from the Downloads page on the Customer Portal. The
MPI for ANSYS Parallel Processing installation steps are displayed when you click the Install MPI
for ANSYS Parallel Processing link.

The ANSYS, Inc. Quick Start Installation Guide, ANSYS, Inc. Quick Start Licensing Guide, System Re-
quirements Guide and complete Installation Help Guide can be accessed through the options located
along the bottom of the launcher.

3. Select the language you want to use from the drop-down menu in the upper right corner. English is the
default.

4. Click the Install ANSYS Products option.

The license agreement appears.

5. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.

6. The directory where you want to install the ANSYS, Inc. products is shown in the Install Directory field.
You can install the products into any directory you want, but you must have write permissions to the
directory you choose. The default is C:\Program Files\ANSYS Inc. We recommend using the default
directory.

Note

You must install all ANSYS, Inc. products into the same location. Installing products into
different locations can cause product components to fail. If you choose an install directory
via the Browse feature, the installation will automatically append \ANSYS Inc\ to the
chosen directory. The installation path can have a maximum of 100 characters, except
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on AUTODYN, which has a maximum of 40 characters. For a network installation, the
same UNC paths or mapped drive letters must be used on the server and all client
computers.

• Leave the Associate file extensions with ANSYS products checkbox marked. This allows you to
double-click files from Windows Explorer to launch the various products.

• If you specify a network location as the installation directory, you should select the Add .NET security
exceptions on the above install directory option. This option allows the .NET binaries that are located
under the \ANSYS Inc directory on the shared machine to be run from the network. To understand
the implications of this security exception for .NET, please contact your system administrator or see
Microsoft’s website http://msdn.microsoft.com/en-us/library/7c9c2y1w(v=vs.80).aspx.

• Choose Disable ANSYS RSS Feed to disable automatic internet feeds to ANSYS, Inc. products.

• Used with network installations, this option allows the .NET binaries that are located under the \ANSYS
Inc directory on the shared machine to be run from the network.

Click Next.

7. If this is a first time installation, you are prompted to enter your license server specification. If you already
have an existing license server specification file, you will not see this window and proceed directly to the
next step.

Enter your ANSYS Licensing Interconnect port number and your ANSYS FlexNet port number. Defaults
are provided and will work in most cases. You may need to check with your IT department to
confirm that the default port numbers are valid or to get different port numbers if necessary.

Specify the hostname for your license server machine(s).

Click Next.

8. All products available in the installation package(s) you downloaded are listed. The installation program
attempts to query your license server to pre-select your installation options. If the query is successful, the
following message is displayed:

Your installation options were pre-selected based upon information from your license server.

If the installation program was unable to query your license server, this message is not displayed
and the default installation options are selected.

You can select or deselect any combination of products. ANSYS Workbench is automatically installed
with most ANSYS, Inc. products; there is no individual product selection for ANSYS Workbench.

If you select AutoCAD, Catia V5, Inventor, NX, Creo Parametric, Solid Edge, or SolidWorks, you will
have additional installation steps. Please see Specifying CAD Configurations (p. 33).

By default, the Install Documentation option is enabled (checked). When enabled, help document-
ation is included as part of the installation process for all products selected. No help documentation
is included with the installation if this box is disabled (unchecked).

You will also see an estimate of the disk space required to install all of the selected components,
and the disk space you have available. The actual amount of disk space required may be less, but
if you choose to run the installation with insufficient disk space available, we strongly recommend
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that you review the log files at the end of the installation to verify that all products were installed
correctly. Installation log files are written to the installation directory.

Note

On a first time installation, if you chose to install any ANSYS Geometry Interfaces, en-
sure that you have also selected at least one ANSYS, Inc. product as part of the in-
stallation. Installing an ANSYS Geometry Interface without an underlying ANSYS,
Inc. product on a first time installation may cause installation errors.

Select/deselect the products you want to install and click Next.

The dates on the licensing files being installed are compared to any that may already exist on your
machine. (This may take a few moments.)

9. A summary of the selected installation data appears. Review the information carefully, and if correct, click
Next to continue the installation.

10. The installation progress screen displays a status bar towards the bottom of the installation window. This
status bar tracks the percentage of packages that have been installed on your computer. Depending on
the number of products you have selected, the installation time required could be lengthy. You will not
be able to interrupt the installation process. Please be patient while the installation completes.

Note

Clicking the View Details Progress Log button opens a second window that displays
the name of each product package as it is uncompressed and installed.

The installation program will first check your system to determine if you have the necessary pre-
requisites. If the prerequisites are not already on your system, the prerequisites will be installed
automatically. You may be asked to run the necessary files (such as the .NET exe), or to reboot your
machine, depending on your existing machine configuration. If you are asked, you will need to
reboot in order to complete the prerequisite installation successfully.

Click Next to continue the installation.

11. The product installation window reappears with a message noting that the installation is complete. A
Launch Survey Upon Exiting option is included here. Clicking Exit while the Launch Survey Upon Ex-
iting is enabled causes your default browser to open, displaying the product survey. Disabling (un-
checking) the Launch Survey Upon Exiting option and then clicking Exit skips the survey.

Note

If prerequisite components necessary for the installation of the ANSYS products
were installed, the following message may be displayed:

A system restart is required before using any ANSYS Products.
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4.2.1.1. Network Server and Product Configuration

To complete a network installation (where the product is installed on one machine and multiple clients
access that installation to run the product) to a file server machine, follow the steps below. A network
installation must be homogeneous, although you can install on different operating systems.

1. Install the product(s) to be shared in a location that all clients can access. Install all platforms that this
machine will host as described in Product Installation with Client Licensing (p. 27).

You must share the entire \ANSYS Inc directory, not just the \v162 directory. If mapping a
drive to the shared location, it must be mapped to the \ANSYS Inc folder.

2. Open the Product Configuration Manager (\\fileservermachine\ANSYS Inc\v162\Product-
Config.exe). Select Install Required Prerequisites. You must be logged in as an administrative user
to install the prerequisites. This step must be completed on all client Windows systems.

3. A configuration status screen appears. This screen displays the required prerequisite installation process.
Once the process is complete, click Exit. The Product Configuration Manager remains open.

4. On each Windows client, update the .NET security settings. By default, the .NET 3.5 Framework prevents
applications from being run over a network. In order to install over a network, each Windows client that
accesses the shared directory requires a modification to its security settings. This modification allows the
.NET binaries that are located under the \ANSYS Inc directory on the shared machine to be run from
the network. To make this modification from the Product Configuration Manager, select Add .NET security
exception for ANSYS, Inc. products. You must have administrative privileges to modify the security
policy.

To understand the implications of this security exception for .NET, please contact your system ad-
ministrator or see Microsoft’s website http://msdn.microsoft.com/en-us/library/
7c9c2y1w(v=vs.80).aspx.

Alternatively, you can allow network execution manually rather than using the Add .NET security
exception for ANSYS, Inc. products option of the Product Configuration Manager. The Add .NET
security exception for ANSYS, Inc. products option runs the Caspol utility, which is located under
the .NET Framework installation, in C:\Windows\Microsoft.NET\Framework64\v2.0.50727
for a 64-bit machine. You can run this utility manually in a command prompt window to open full
trust to files on the shared drive.

On a 64-bit machine, run the following command:

<os drive>\Windows\Microsoft.NET\Framework64\v2.0.50727\Caspol.exe -m -ag
     <CodeGroup> -url file://x:/* FullTrust

where x is the mapped drive or UNC path where the product is installed, and CodeGroup is the
appropriate Caspol permissions level. We recommend a CodeGroup setting of 1.2. If that setting
does not work or is not appropriate for your environment, please see the Caspol documentation
available from Microsoft or contact your system administrator.

You must install Caspol as an administrative user. If running this from the command line in Windows
7 or Windows 8.1, you must start the command prompt as Administrator, or the command will fail.

5. If you are sharing the Mechanical APDL product, edit the tlbrlist162.ans file, located in
\v162\ansys\gui\en-us\toolbars on the Windows file server. The file should read as follows:
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\\fileservermachine\ANSYS Inc\v162\ansys\gui\en-us\toolbars\ANSYSSTANDARD.TLB
\\fileservermachine\ANSYS Inc\v162\ansys\gui\en-us\toolbars\ANSYSABBR.TLB
\\fileservermachine\ANSYS Inc\v162\ansys\gui\en-us\toolbars\ANSYSGRAPHICAL.TLB

6. For all types of network installations, from each client Windows machine, you will need to run Product-
Config.exe. If the Product Configuration Manager has been closed, please reopen it as described above.

7. Select Configure Products.

8. Select the products you want to configure. Click Configure.

Note

CFD-Post is automatically configured when CFX, Fluent, Polyflow, or Icepak is configured,
or if CFD-Post is selected.

9. An informational message box appears as each product is configured.

All operations and error messages that are encountered while using the product configuration (or
unconfiguration) option are written to the productConfig.txt file in the %TEMP% directory of
the client machine. No log files are written to the machine that is hosting ProductConfig.exe.

Note

ProductConfig.exe can also be run in batch mode using the ‘-silent' flag, which may
be useful for automating configuration for multiple systems or across a Microsoft
Windows HPC cluster. For more information see Silent Mode Operations (p. 45).

10. Select Configure CADs.

11. The CAD Configuration Manager opens. Run this utility for all of the CAD products you need to configure.
See Using the CAD Configuration Manager for detailed instructions on running this utility, or select Help
from the menu bar in the CAD Configuration Manager.

12. When the configuration is completed, you will see shortcuts to each product in Windows 7 under Start
> All Programs > ANSYS 16.2 and in Windows 8.1 under All apps> ANSYS 16.2.

Unconfigure To unconfigure products that have previously been shared, use the following procedure:

1. From each client machine, in Windows 7, select Start > All Programs > ANSYS 16.2 > Utilities> Product
Configuration 16.2 and in Windows 8.1, right-click the Start Screen> All apps> ANSYS 16.2> Product
Configuration 16.2.

2. Select Unconfigure Products.

3. Select the products you want to unconfigure. Click Unconfigure. When unconfiguring products, be aware
that WB/Common should be unconfigured last, after all other products are unconfigured. If you are un-
configuring some but not all products, do NOT unconfigure WB/Common, or your remaining products
will not run correctly.
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CFD-Post CFD-Post can be configured as a standalone product; however, as a standalone product,
it is also automatically configured with Fluent, Polyflow, and Icepak. To unconfigure CFD-Post, you
must select all of these products to unconfigure, regardless if they are configured locally.

• If you choose to unconfigure standalone CFD-Post without unconfiguring the other products, you will
not be able to proceed with the unconfigure. You will need to revise your selections before continuing.

• If you choose to unconfigure all of the other products that include CFD-Post but you do not select CFD-
Post, then CFD-Post will not be unconfigured.

4. The user interface billboard displays the status of each product as it is unconfigured. The shortcuts to
each product are now removed.

4.2.1.2. Specifying CAD Configurations

Creo Parametric

1. If you selected Creo Parametric, you will have to choose which Creo Parametric product to configure. You
can choose the Reader (non-associative), Workbench Associative Interface (requires that the CAD product
be installed), or skip and configure later (using the CAD Configuration Manager).

2. If you choose the Workbench Associative Interface, you may need to specify the Creo Parametric language,
the Creo Parametric command, and the full Creo Parametric installation path (C:\Program
Files\PTC\Creo 1.0\Parametric by default) for an existing Creo Parametric installation. Click
Next.

NX

1. If you selected NX, you will have to choose which NX product to configure. You can choose the Reader
(non-associative), Workbench Associative Interface (requires that the CAD product be installed), or skip
and configure later (using the CAD Configuration Manager).

2. If you choose the Workbench Associative Interface and the UGII environment variables were not set, you
may need to specify the NX installation path for an existing NX installation. If you are an administrative
user, a file required to load the NX plug-in is placed in the administrative user's Application Data folder
by default, which may not be accessible by other, non-administrative users. To allow non-administrative
users to run, you will need to define the environment variable UGII_CUSTOM_DIRECTORY_FILE prior
to installation and specify a location where other users have read access. Alternatively, you can run the
CAD Configuration Manager after the installation and provide an updated location for the NX Custom
Directory File Path under the NX tab.

3. If you selected the ANSYS ICEM CFD NX Interface product but not the NX Geometry Interface product on
the product selection screen, you may need to specify the NX installation path or choose to skip config-
uring NX and use the CAD Configuration Manager to configure later.

CATIA v5

• If you selected CATIA v5 and any product that includes ANSYS Workbench, you will be required to select
the appropriate CAD reader/plugin for ANSYS Workbench. You can choose to configure the Reader,
CADNexus CAPRI CAE Gateway, or skip and configure later (using the CAD Configuration Manager).
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SolidWorks and Autodesk Inventor

• If you selected Inventor and/or SolidWorks as one of your CAD products, you will have to choose which
Inventor and/or SolidWorks product to configure. You can choose the Reader (non-associative), Workbench
Associative Interface (requires that the CAD product be installed), or skip and configure later (using the
CAD Configuration Manager).

If you have not yet installed these programs, or do not know the requested information, you can choose
to skip these configuration steps. If you skip these steps, you will need to manually configure these
CAD interfaces using the CAD Configuration Manager before you can successfully import models into
Mechanical APDL, ANSYS Workbench, or ICEM CFD. You can access the CAD Configuration Manager
in Windows 7 (Start > All Programs > ANSYS 16.2 > Utilities > CAD Configuration Manager 16.2)
and in Windows 8.1 (Right-click the Start Screen> All apps> ANSYS 16.2 > CAD Configuration
Manager 16.2). See Configuring CAD Products (p. 53) for more information on using the CAD Config-
uration Manager.

4.2.2. ANSYS License Manager Installation

Because you will be using a network server, you must install and configure the ANSYS, Inc. License
Manager on the server machine. The License Manager controls access to the ANSYS, Inc. products you
have purchased.

1. On the server machine, navigate to the directory where the installation packages reside. Right-click the
setup.exe file and select Run as administrator. The ANSYS, Inc. Installation Launcher appears. Click
Install ANSYS License Manager.

2. You will see a warning stating that if the license manager is currently running, it will be shut down. You
may safely ignore this message and click OK.

3. The license agreement appears. Read the agreement, and if you agree to the terms and conditions, click
I Agree. Click Next.

4. The directory where the license manager will be installed is shown in the Install Directory field. Accept
the default directory and click Next.

Note

You are unable to change the installation directory for a computer that currently contains
an instance of the ANSYS, Inc. License Manager or ANSYS Electromagnetics License
Manager. To change the installation directory location, you must first uninstall any pre-
vious versions of both products.

5. The ANSYS, Inc. License Manager is selected as the only product available to install. As with the product
installation, the required and available disk space numbers are shown. Click Next.

6. A summary screen appears that lists the products to be installed. Because this is a license manager install-
ation, the ANSYS, Inc. License Manager is the only product listed.

Click Next. The license manager installation begins.

After the License Manager installation has been completed, the Launch License Management
Center upon exiting option is included on the screen. The ANSYS License Management Center
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is a browser-based user interface that centralizes many of the ANSYS product licensing administrative
functions. If you do not want to launch the License Management Center, uncheck the Launch Li-
cense Management Center upon exiting option.

7. Click Exit to close the  License Manager Installation screen.

8. Click Exit to close the ANSYS, Inc. Installation Launcher.

9. From the machine on which the products were installed, choose Start> Programs> ANSYS 16.2>
<product> to launch the ANSYS, Inc. products that you have installed.

4.2.2.1. Registering the License Server

If you are a new user who has not received a license file for your server or if you add or change a license
server machine, follow this procedure to register your license server information. See the ANSYS, Inc.
Licensing Guide for more information on selecting license servers (Selecting License Server Machines)
and on using the ANSYS License Management Center (License Server Administration Using ANSYS License
Management Center).

1. Open the ANSYS License Management Center.

2. Click the Get System Hostid Information option to display your system ID code(s).

3. Select the system ID you wish to use and click SAVE TO FILE.

A text file containing your system ID information is created.

4. Forward this text file to your ANSYS sales representative so that a license file can be created for you.

5. Add your license files though the ANSYS License Management Center. For these steps, see Adding a License
with the ANSYS License Management Center.

After completing the installation process, please refer to Post-Installation Instructions (p. 37)
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Chapter 5: Post-Installation Instructions

The following post-installation procedures apply to all ANSYS, Inc. products. Individual products may
have additional post-installation procedures; please refer to the following sections for each product:

5.1. Post-Installation Procedures for Mechanical APDL and ANSYS Workbench Products
5.2. Launching ANSYS, Inc. Products
5.3. Running the ANS_ADMIN Utility for Mechanical APDL /ANSYS Workbench Products
5.4. Product Localization

Note

If the installation program reported any errors, please review the installation error file (in-
stall.err) located in the ANSYS Inc directory. Contact your ANSYS Support representative if
you have any questions.

It may also be necessary to establish some system settings, including path names and environment
variables. See your operating system documentation for specific instructions on setting paths and en-
vironment variables.

1. Set the following environment variables based on the behavior you want.

• The ANSYSLIC_DIR environment variable sets the location of the ANSYS licensing directory hierarchy.
The default value is c:\Program Files\ANSYS Inc\Shared Files\Licensing. You probably
will not need to reset this variable, unless you change the location of the licensing files.

To set environment variables:

Windows 7: Right-click Computer and choose Properties. Click Advanced System Settings, and
click Environment Variables. Click New. Type the name in the Variable Name field and the desired
setting in the Variable Value field. Click OK on all dialog boxes.

Windows 8.1: From the Start Screen, right-click, select All apps and then click the File Explorer
icon. On the left side of the File Explorer, right-click Computer and choose Properties. Click Ad-
vanced System Settings, and click Environment Variables. Click New. Type the name in the
Variable Name field and the desired setting in the Variable Value field. Click OK on all dialog boxes.

If you have any command prompts or console windows open when you set or reset environment
variables, those windows need to be closed and restarted in order to pick up the new settings.

2. Set the home directory. To set a home directory in Windows, you need to set a HOMEDRIVE environment
variable to the desired drive letter (including the colon) and a HOMEPATH environment variable to the
desired path. For example:

HOMEDRIVE=C:
HOMEPATH=\Users\Mine

3. Set the license manager to start automatically at boot time. For platform-specific instructions, see License
Manager Automatic Startup Instructions in the ANSYS, Inc. Licensing Guide.
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4. Designate server(s) for license checkout and establish necessary user privileges (recommended but not
required). For information on these tasks, see Post-Installation Instructions for the License Manager in the
ANSYS, Inc. Licensing Guide.

5. Make a backup copy of the \ANSYS Inc directory.

6. Verify the product installation by selecting each product from the Start menu to verify that they each
start and run correctly. You must be pointing to a valid license server machine before you can verify the
installation.

7. If you chose not to set file associations during the installation, you may want to run the File Association
utility now to configure the ANSYS file types. Administrative privileges are required to run this utility

For Windows 7, select Start> All Programs> ANSYS 16.2> Utilities> File Association 16.2 and
for Windows 8.1, right-click the Start Screen> All apps> ANSYS 16.2> File Association 16.2.

For network installations, run the File Association utility on each client computer.

You can also run the File Association utility in silent mode:

<install_dir>\v162\commonfiles\tools\<platform>\fileassoc.exe -silent

You can see help on the fileassoc.exe by issuing -help. File associations are as follows:

File ExtensionANSYS, Inc. Product

.db, .dbb, .grphMechanical APDL

.mres, .resANSYS CFD-Post

.cfx, .cvf, .def, .mdefANSYS CFX

.acpANSYS Composite PrepPost

.casANSYS Fluent

.prj, .tin, .unsANSYS ICEM CFD

.scdoc, .scjournalANSYS Space Claim Direct
Modeler

.ad, .agdb,  .aqdb, .bgd, .cmdb, .dsdb, .engd, .fedb,

.mechdat, .meshdat, .wbdb, .wbpj, .wbpz
ANSYS Workbench

Quality Assurance Services: If you require verification of Mechanical APDL, the Mechanical Application,
Fluent, or CFX, ANSYS, Inc. offers Quality Assurance services. If you are interested in this service, go to
http://www.ansys.com/Support/Quality+Assurance/Quality+Services or call the ANSYS, Inc. Corporate
Quality Group at (724) 746-3304.

5.1. Post-Installation Procedures for Mechanical APDL and ANSYS
Workbench Products

The following post-installation procedures apply only to the Mechanical APDL and ANSYS Workbench
products. These are in addition to the post-installation procedures noted above for all products.

• Set the following environment variables based on the behavior you want. Set the environment variables
following the conventions of your operating system. Not all of these are required for all integrated ANSYS
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Workbench products (such as ANSYS Autodyn), but setting them correctly for ANSYS Workbench will in
no way hinder the performance of the other products.

• The ANSYS162_DIR environment variable sets the location of the ANSYS directory hierarchy. The default
value is c:\Program Files\ANSYS Inc\V162\ANSYS. You probably will not need to reset this
variable, unless you change the location of the installed files.

• ANSYS162_PRODUCT - set this to the correct product variable to run Mechanical APDL to start with
the correct Mechanical APDL product without specifying the -p command modifier each time.

• ANS_CONSEC - set this to YES to disable Mechanical APDL dialog boxes and allow multiple jobs to run
consecutively without waiting for user input. Settings for ANS_CONSEC are:

GPF Dialog Box on
Error

Batch Dialog
Box

Value of
ANS_CONSEC

YesNoNot defined/default

NoNoYES

YesYesNO

• ANSYS_LOCK - set to ON (default) to create file locks to prevent users from opening a new job with
the same name and in the same directory as the current job.

• ANSYS162_MAT161 - set this environment variable to 1 to enable use of the LS-DYNA *MAT_COMPOS-
ITE_MSC material (requires an LS-DYNA MAT_161 license).

• ANSYS162_MAT162 - set this environment variable to 1 to enable use of the LS-DYNA *MAT_COMPOS-
ITE_DMG_MSG material (requires an LS-DYNA MAT_162 license).

• LSTC_LICENSE - This is an LS-DYNA environment variable that controls which license manager is used
by the LS-DYNA executable. It is set to ANSYS during installation; changing this environment variable
will prevent ANSYS LS-DYNA from using your ANSYS licenses when running the executable.

5.1.1. Post-Installation Procedures for ANSYS CFX and ANSYS CFD-Post

After installing the ANSYS CFX or ANSYS CFD-Post software, verify the installation as follows:

1. In Windows 7, select Start> All Programs> ANSYS 16.2> Fluid Dynamics> CFX 16.2. In Windows 8.1,
right-click the Start Screen> All apps> ANSYS 16.2> CFX 16.2.

The CFX 16.2 Launcher opens.

2. In the Working Directory field of the Launcher, type the path to the examples directory, which by default
is:C:\Program Files\ANSYS Inc\v162\CFX\examples

3. Click CFD-Post 16.2. CFD-Post opens.

4. Select File > Load Results. The Load Results File window opens.

5. Select StaticMixer_001.res and click Open.

A wireframe of a mixer appears in the 3D Viewer.
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6. Select Session > Play Session. The Play Session File window opens. Select StaticMixerPost.cse and
click Open.

The mixer changes orientation, displays a plane colored by temperature, hides the plane, then
loads a vector plot of temperature located on the plane.

7. Select File > Close and close the case without saving.

8. To exit CFD-Post, select File > Quit.

If any of the installation verification steps fails, contact your ANSYS Support representative.

5.1.2. Post-Installation Procedures for ANSYS Fluent

After installing the ANSYS Fluent software, you will need to reset the default values in the ANSYS Fluent
launcher as follows:

1. Verify that the FLUENT_INC environment variable is not set. From the Control Panel, select System and
click the Advanced tab. Click Environment Variables. Find and delete the FLUENT_INC variable.

2. In Windows 7, select Start> All Programs> ANSYS 16.2> Fluid Dynamics> Fluent 16.2. In Windows 8.1,
right-click theStart Screen> All apps> ANSYS 16.2> FLUENT 16.2.

3. Click Default.

4. Click Yes when asked if you want to discard the LAUNCHER history.

5. Click Cancel if you do not want to start Fluent at this time. The new defaults will have been saved.

Please refer to the ANSYS Fluent Quick Start Guide for more information.

5.1.3. Post-Installation Procedures for ANSYS Polyflow

Polyflow no longer requires the FLUENT_INC environmental variable. It should be deleted as is recom-
mended for Fluent:

• From the Control Panel, select System and click the Advanced tab. Click Environment Variables. Find and
delete the FLUENT_INC variable.

5.1.4. Post-Installation Procedures for ICEM CFD

If you are running ICEM CFD over the network, you may not be able to access ICEM CFD Help using
the Help menu. To access ICEM CFD Help, navigate to commonfiles\help\en-us in the installation
directory on the server machine and copy the file icemcfd_help.chm to your local machine. Double-
click the local copy to view the help.

5.1.5. Post-Installation Procedures for Other Products

BladeGen If you are running BladeGen on Windows 7, in order to access the BladeGen online help,
you need to install WinHlp32.exe, which is available from Microsoft.

BladeEditor In order to use BladeEditor, you must set the Geometry license preference to ANSYS
BladeModeler as follows:
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1. In the ANSYS Workbench menu, select Tools> License Preferences.

2. In the License Preferences dialog box, click the Geometry tab.

3. If ANSYS BladeModeler is not the first license listed, then select it and click Move up as required to move
it to the top of the list. If ANSYS BladeModeler is not in the list, then you need to obtain an ANSYS
BladeModeler license.

4. Select ANSYS DesignModeler in the list and set its value to 0 (which means “Don't Use”). This step prevents
DesignModeler from using an ANSYS DesignModeler license when an ANSYS BladeModeler license is not
available.

5. Click OK to close the dialog box.

FEMGV For ANSYS Aqwa customers, FEMGV is also available as a separate, standalone installation,
available via media or the ANSYS Customer Download Center.

5.2. Launching ANSYS, Inc. Products

To launch ANSYS, Inc. products on Windows 7 platforms, choose the product from the ANSYS 16.2
program group under the Start menu (Start> All Programs> ANSYS 16.2) and on Windows 8.1, under
All apps.

For Mechanical APDL, you can also use the launcher:

Windows 7: Start> All Programs> ANSYS 16.2> Mechanical APDL Product Launcher 16.2.

Windows 8.1: Start Screen> All apps> ANSYS 16.2> Mechanical APDL Product Launcher 16.2.

5.3. Running the ANS_ADMIN Utility for Mechanical APDL /ANSYS
Workbench Products

You may need to run the ANS_ADMIN utility to relink Mechanical APDL if you use the customization
tools. For more information on individual options available with this utility, see the online help accessible
from Help buttons on the utility dialog boxes. You can launch ANS_ADMIN without administrative
privileges, but some of the options require administrative privileges. If certain options are grayed out,
you do not have the necessary system administrator privileges necessary for that option, or the corres-
ponding product may not be installed.

To run the ANS_ADMIN utility from Windows 7, choose Start> All Programs> ANSYS 16.2> Utilities>
ANS_ADMIN 16.2. To run the ANS_ADMIN utility from Windows 8.1, right-click the Start Screen> All
apps> ANSYS 16.2> ANS_ADMIN 16.2.

5.4. Product Localization

Many ANSYS, Inc. products are available in multiple languages, including English, German, French, and
Japanese. For those products that are localized, you are able to view the GUI and messages in the
specified language. See your specific product documentation for instructions on choosing a localized
version of the product.

All products that are localized define the language via the languagesettings.txt file. In most
cases, you will not have to manually edit this file. If you do need to edit it manually, you can use one
of the following values:
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en-us (English, default)
de (German)
fr (French)
ja (Japanese)

ANSYS, Inc. applications will look for the languagesettings.txt file in the following locations, in
order:

1. %appdata%\ANSYS\v162

2. <install_dir>\ANSYS Inc\v162\commonfiles\Language

ANSYS, Inc. licensing also looks for the languagesettings.txt in the licensing languages subdir-
ectories in order to display the server ANSLIC_ADMIN utility and the ANSYS, Inc. Licensing Interconnect
message and log files in a different language.

Some products are not fully localized but offer only the messages in a translated version. See the fol-
lowing section for instructions on translated message file installation.

5.4.1. Translated Message File Installation for Mechanical APDL /ANSYS
Workbench Products

If your ANSYS, Inc. sales representative has supplied you with message files translated into your local
language, use the following procedure to install and access these files from within Mechanical APDL:

1. Create an appropriately named subdirectory to hold the message files. For example, if your local language
is French, create a directory in the following location:

<os drive>\Program Files\ANSYS Inc\V162\ANSYS\docu\fr

2. Copy the message files (msgcat.162,msgidx.162, and msgfnm.162) into the newly created subdir-
ectory.

3. Access these message files by using the -l command line option. For example:

ansys162 -l fr

Or, when you are running Mechanical APDL from the Mechanical APDL launcher, choose the Lan-
guage Selection option and then pick the desired language.

You must create a newly translated message file for each release of Mechanical APDL because error
messages may occur in a different order for each release.

Release 16.2 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.42

Post-Installation Instructions



Chapter 6: Installing the ANSYS, Inc. Product Help Documentation
Only

Performing the ANSYS product help documentation installation places the entire help library onto your
computer.

To perform the installation:

1. Save all data and close all Windows applications before continuing.

2. If you downloaded the installation files or if you are installing from a DVD/USB with autorun disabled,
navigate to the location of the setup.exe file. Right-click the setup.exe file and select Run as administrator.

The ANSYS, Inc. Installation Launcher appears.

3. From the options along the left side of the launcher click Install ANSYS Documentation Only.

The license agreement appears.

4. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.

5. The directory where you want to install the ANSYS, Inc. help documentation is shown in the Install Direct-
ory field. You can install the products into any directory you want, but you must have write permissions
to the directory you choose. The default is C:\Program Files\ANSYS Inc. We recommend using the default
directory.

Click Next.

6. A summary screen appears listing your help documentation installation. You will also see an estimate of
the disk space required to install all of the selected components, and the disk space you have available.

Click Next to begin the installation.

7. When the help documentation installation has completed, click Exit. The product installation window re-
appears. You can close this window at this time.

Note

Alternatively, you can run the document installation by running the SetupDocOnly.exe
installation file. This file is located in the windows directory on USB drives.

The ANSYS help documentation can be installed silently by running the SetupDocOnly.exe installation
file with the –silent flag. For more information, see Silent Mode Operations.
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Chapter 7: Silent Mode Operations

7.1. Installing ANSYS, Inc. Products

This section explains how to install ANSYS, Inc. products.

ANSYS, Inc. requires that you have full administrative privileges when installing any software on Microsoft
Windows 7 or Windows 8.1. Non-administrative accounts do not usually have the permissions required
to access system areas that installation programs often need to modify. “Full administrative privileges”
means that you are running as administrator with UAC turned off, or you are running as administrator
with UAC turned on and Run as Administrator selected. Because of changes to the UAC functionality,
it is necessary that you right-click and select Run as Administrator from the context menu when in-
stalling to Windows 8.1.

Windows 7 and Windows 8.1 use a feature called User Account Control (UAC) to control privileges and
automatically reduce the potential of security breaches in the operation system. However, UAC limits
your accessibility to system areas and can cause unpredictable behavior in ANSYS, Inc. products, as
noted below.

7.1.1. Silent Mode Operations

ANSYS, Inc. supports silent mode operations, including installation, configuring/unconfiguring, and
uninstalling.

You can specify the following product flags. These flags are all valid for a silent install. However, because
of the way the products are packaged, not all of these flags may be valid for a silent configuration/un-
configuration or uninstall. Not all products are available on all platforms.

For silent mode operations, if you do not specify any product arguments, all available products will be
installed, configured, or uninstalled.

Product Flags

product_flagProduct

-mechapdlMechanical APDL

-ansyscustANSYS Customization Files

-autodynANSYS Autodyn

-lsdynaANSYS LS-DYNA

-cfdpostANSYS CFD-Post

-cfxANSYS CFX

-turbogridANSYS TurboGrid

-fluentANSYS Fluent

-polyflowANSYS Polyflow

-aqwaANSYS Aqwa
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product_flagProduct

-icemcfdANSYS ICEM CFD

-aimANSYS AIM

Note: Installing any of the above products will install ANSYS Workbench.

-acpANSYS Composite PrepPost

-icemproeANSYS ICEM CFD Creo Parametric Interface

-icepakANSYS Icepak

-rsmRemote Solve Manager Standalone Services

-tcengANSYS TeamCenter Engineering

-proeCreo Parametric

-ugNX

-catia4CATIA 4.x

-catia5CATIA V5

-catia6CATIA V6

-parasolidParasolid

-acisACIS

-solidworksSolidWorks

-solidedgeSolid Edge

-adinventorAutodesk Inventor

-cocreateCreo Elements/Direct Modeling

-jtopenJTOpen

-acadAutoCAD

-solidworks_readerSolidWorks Reader

-solidworks_pluginSolidWorks Plugin

-catia5_readerCATIA 5 Reader

-catia5_pluginCATIA 5 Plugin

-adinventor_readerAutodesk Inventor Reader

-adinventor_pluginAutodesk Inventor Plugin

-proe_readerCreo Parametric Reader

-proe_pluginCreo Parametric Plugin

-ug_readerNX Reader

-ug_pluginNX Plugin

7.1.1.1. Silent Product and License Manager Installation

Caution

A silent license manager installation could shut down the ANSYS, Inc. License Manager, af-
fecting other users who are using that license server machine.
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You can deploy an ANSYS, Inc. product installation in silent mode. The general form to run a silent
product installation, including the client licensing, from the Start>Run menu is:

setup.exe -silent -product_flag

Note

In Windows 8.1 it is necessary to run silent commands from an administrator prompt.
To access a Run as Administrator command prompt, click Start Screen> All apps> right-
click the Command Prompt Icon> select Run as Administrator.

The above form will install the products specified (see the list of product_flags above). Additional
command line arguments are available; please see the list below.

For example, to install TurboGrid and Icepak to the default installation directory, issue the following
command:

setup.exe -silent -install_dir “C:\Program Files\ANSYS Inc” -turbogrid -icepak

To install the ANSYS License Manager on Windows systems that will act as license servers, you must
run the setupLM.exe:

setupLM.exe -silent

The silent license manager installation is valid only for the default Licensing Configuration option "Run
the ANSYS Licensing Interconnect with FLEXlm." Please see Installing the ANSYS License Manager of
the ANSYS, Inc. Licensing Guide for more information.

If you are installing the license manager to a non-default installation directory, you can use the silent
installation method, but only for the initial installation. To change the license manager installation dir-
ectory for future installations, you will need to uninstall the license manager before reinstalling to a
different directory.

You can use the following arguments when running a silent installation:

Initiates a silent installation.-silent

Specifies the directory to which the product is to be installed. For the installation
directory, you must enclose the path in quotes if you have spaces in the pathname.

-install_dir
"path"

If you want the product to install to the default location, you can omit the -in-
stall_dir argument. The default location is <os drive>:\Program
Files\ANSYS Inc\.

Specifies one or more products to install. If you omit the -product_flag
argument, all products will be installed. See the list of valid product_flags
above.

-product_flag

You can specify an options file that lists the products you want to install. To do
so, you must provide a full path to a file containing desired products. See Specifying
Products with an Options File (p. 49) for more details.

-productfile
"path"

Disables automatic internet feeds to ANSYS, Inc. products.-disablerss

Allows the .NET binaries that are located under the \ANSYS Inc directory on
the shared machine to be run from the network. You must have administrative

-caspol

privileges to modify the security policy. Use this option when you specify a network
location as the installation directory. To understand the implications of this security
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exception for .NET, please contact your system administrator or see Microsoft’s
website http://msdn.microsoft.com/en-us/library/7c9c2y1w(v=vs.80).aspx.

Displays a list of valid arguments for a silent installation.-help

Specifies the location of the license file to install. If the path is not specified or if
the path is the same as the existing license file, the license file will not be installed.
Valid only when doing a silent license manager installation (setupLM.exe).

-licfilepath
"path"

Specifies a language to use for the server ANSLIC_ADMIN utility and the ANSYS,
Inc. Licensing Interconnect log file. Use the language directory name in the

-setliclang
language

language subdirectory of the licensing directory (en-us, fr, de, etc.) as the
language value. This flag can be used during a GUI installation as well. Valid
only when doing a license manager installation (setupLM.exe).

Specifies information to be used by the client for the license server. Valid only in
conjunction with a silent installation (setup.exe). The format is:

Single license server:

-licserverinfo

LI port number:FLEXlm port number:hostname

Example:

2325:1055:abc

Three license servers:

LI port number:FLEXlm port number:hostname1,hostname2,host-
name3

Example:

“2325:1055:abc,def,xyz”

The default values for the Licensing Interconnect and FlexNet port numbers
(2325 and 1055, respectively) will be used if they are not specified. However,
you do need to include the colons. In a three-server environment, you also
need to enclose the values in quotes (Windows only).

Example:

::abc

or

“::abc,def,xyz”

Information specified via -licserverinfo will be appended to existing
information in the ansyslmd.ini file. To change information already in
your ansyslmd.ini file, you must use the ANSLIC_ADMIN utility.

By default, for the products that are being installed, all help documentation is
included. The -nohelp argument removes all help from the installation.

-nohelp

Specifies a language to use for the products.-lang
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The silent installation process will automatically close certain applications, possibly resulting in lost data.
You should always close all programs before starting a silent install. A silent install will first install any
necessary prerequisites that are not already on your system and then continue with the installation.
You must have administrative privileges to install prerequisites; if not, the silent install will exit and
write a message to the log file.

Installation log files are located in the installation directory: install.log contains installation messages,
and install_licconfig.log contains licensing installation messages. In rare circumstances with
a silent licensing installation, the licensing installation messages may not be written to the install_lic-
config.log (for example, if the silent licensing installation aborts); in these cases, you may find error
messages in the .ansys_install_temp_licconfig_<user>_<index>.log file, located in
%TEMP%.

For more information on the silent license manager installation, see Installing the ANSYS License Manager
of the ANSYS, Inc. Licensing Guide.

Specifying Products with an Options File

You can also specify an options file on the command line using the -productfile "path” option.
The options file can specify which products you want to install. The options file can contain all possible
products, with the products you do not want to install commented out, or it can contain only the
products you want to install. An example options file is shown below. In the example, Creo Parametric
and NX are commented out using the acceptable comment indicators. When using the options file, do
not include the dash (-) before the product name.

mechapdl
ansyscust
autodyn
cfdpost
cfx
turbogrid
fluent
polyflow
icemproe
icepak
::proe
REM ug

To run with NX and Creo Parametric:

• NX: Verify that your UGII environment variables are set, and the configuration will pick them up automatically.

• Creo Parametric: Verify that the following environment variables are set:

PROE_START_CMD162=C:\Program Files\PTC\Creo 1.0\Parametric\bin\para-
metric1.bat (or your Creo Parametric start command)
PROELOADPOINT= C:\Program Files\<Creo_dir>

Silent Prerequisites Installation

The ANSYS, Inc. product installation requires several prerequisites. These prerequisites often require
administrative permissions to install. If you want to install as a non-administrative user but require
prerequisites, you can install the prerequisites separately by running InstallPreReqs.exe from
the top level directory as an administrator. You can also install the prerequisites silently using the fol-
lowing command:

InstallPreReqs.exe -silent 
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7.1.1.2. Silent Product Configuration/Unconfiguration

You can also run the ProductConfig.exe via command line (i.e., silent mode) to configure or un-
configure products.

From each client machine, run the ProductConfig.exe -silent with the following options:
-config, -unconfig, -prereqs, -caspol, and -product_flag. These options are described
below.

• -config/-unconfig -- Use with the -silent option to indicate that products should be configured/un-
configured.

• -prereqs -- Required to install the necessary prerequisites on your system. Prerequisites must be installed
once on each machine.

• -caspol -- Required to modify the necessary .NET security settings to allow the product to run across the
network. This option needs to be run once on each machine.

• -product_flag -- Use to specify which products should be configured; see the above list of
product_flags. If you do not specify one or more products, all products that have been installed will be
configured.

• Use the -help option for a list of commands available for use with ProductConfig.exe.

An example command for silent configuration is:

"\\machineabc\Program Files\ANSYS Inc\v162\ProductConfig.exe" -silent -prereqs
"\\machineabc\Program Files\ANSYS Inc\v162\ProductConfig.exe" -silent -caspol
"\\machineabc\Program Files\ANSYS Inc\v162\ProductConfig.exe" -silent -config

All operations and error messages that are encountered while using the silent product configuration/un-
configuration option are written to the productConfig.txt file in the %TEMP% directory of the client
machine. No log files are written to the machine that is hosting ProductConfig.exe.

7.1.1.3. Silent Media Installation

To run a silent installation from the media, you can either:

• Copy the contents of each DVD to a folder on the machine's hard disk such that the 162-<number>.dvd
files of each DVD are located in the same directory. You can then proceed with the silent installation as de-
scribed earlier.

• Place all of the media in separate drives (any combination of virtual ISO mounts or hardware drives) so that
they can be accessed simultaneously during the installation. Then run the silent installation as described
earlier, but include the additional -media_dir2 <path> option for each drive:

setup.exe -silent -product_flag -media_dir2 <path>

The installer uses the mount directory from which it was launched as the first media path; you need
to specify only the location of the subsequent DVD(s) using the -media_dir2 option shown in the
example above.

7.1.1.4. Silent Uninstall

To run a silent uninstall, run the following from some location other than the \v162 directory:

C:\> <installation path>\v162\Uninstall.exe -silent
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The silent uninstall will unconfigure and remove all products and remove the entire \v162 directory,
including any user files or subdirectories that you have added to the \v162 directory.

Because of the way ANSYS, Inc. products are packaged, not all of the product_flags shown above
are valid. To uninstall individual products, use the following product options in conjunction with the
-silent argument:

-mechapdlMechanical APDL

-aqwaANSYS Aqwa

-cfxANSYS CFX

-cfdpostANSYS CFD-Post

-fluentANSYS Fluent

-polyflowANSYS Polyflow

-icemcfdANSYS ICEM CFD

-turbogridANSYS TurboGrid

-icepakANSYS Icepak

-rsmRemote Solve Manager Standalone
Services

For example, to uninstall only TurboGrid and Icepak, issue the following command:

C:\> <installation path>\v162\Uninstall.exe -silent -turbogrid -icepak

You can also issue the -help option to see a list of valid arguments for a silent uninstall.

Uninstalling CFD-Post CFD-Post can be installed as a standalone product. As a standalone product,
it is also automatically installed with Fluent, Polyflow, and Icepak. To uninstall the standalone version
of CFD-Post, you must specify -cfdpost as well as all of the above products that you have installed.

Note that CFD-Post is also installed with CFX; however, you do not need to uninstall CFX to uninstall
the standalone version of CFD-Post, and uninstalling the standalone version of CFD-Post will not remove
the CFD-Post capability from CFX.
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Chapter 8: Configuring CAD Products

The connection, geometry interface, and other CAD functionality for all supported CAD products is in-
cluded with the ANSYS release media. Select the CAD systems you want to install during the installation
process. If you choose not to install CAD systems during the installation, you can install them at a later
date.

To run the connection or geometry interface functionality, you need to:

1. Ensure that the CAD product is correctly installed and licensed.

2. Ensure that you have the correct ANSYS, Inc. license(s).

3. Run the installation setup.

For complete information about the files you can import and the platforms supported by the connection
capability, see the ANSYS Connection User's Guide. For more information about geometry interface in-
formation in ANSYS Workbench, see the topics Attach to Active CAD Geometry and Import External
Geometry File in the ANSYS DesignModeler help.

Caution

Be sure to install Mechanical APDL and the connection functionality from the same release.
If you attempt to run the latest connection functionality on a machine that is running an
earlier release of Mechanical APDL, or vice versa, the connection may fail.

The connection for Creo Parametric requires you to run Mechanical APDL, Creo Parametric and the
connection for Creo Parametric on the same machine. The connection for NX requires you to run
Mechanical APDL, NX, and the connection for NX on the same machine. The connections for CATIA,
SAT, and Parasolid do not require any additional CAD installation.

8.1. Using the CAD Configuration Manager

The CAD Configuration Manager allows you to configure geometry interfaces for Mechanical APDL
and ANSYS Workbench. CAD configuration is typically handled during the product installation; however,
if you chose to skip those steps, or if you make changes to your local CAD configuration between releases
(for example, you install, move, or update your CAD package, or remove it entirely), you can use this
utility.

The CAD Configuration Manager is organized into several tabs:

• CAD Selection

• Creo Parametric

• NX

• Teamcenter (active on Windows only)
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• CAD Configuration

This document describes how to use the CAD Configuration Manager as a wizard, beginning with the
CAD Selection tab and using the Next button to progress through the configuration process. You can
also manually select each tab to progress through the configuration process; both methods work the
same. However, the applicable tabs will not be enabled until you choose the associated product on the
CAD Selection tab.

1. From Windows 7, click Start > All Programs > ANSYS 16.2 > Utilities > CAD Configuration Manager
16.2. From Windows 8.1, right-click the Start Screen> All apps> ANSYS 16.2> CAD Configuration
Manager 16.2.

2. On the CAD Selection tab, choose the CAD products that you need to configure. Click Next.

3. If you did not select any CAD interfaces the necessary prerequisites will be registered, enabling Geometry
(DesignModeler). You must run the CAD Configuration Manager as an administrative user for some
CAD registrations to take place. Select the CAD Configuration tab and click Configure Selected CAD
Interfaces to register the prerequisites.

4. If you selected Creo Parametric as one of your CAD products, you will have to choose which Creo Para-
metric product to configure:

a. The Reader option specifies the non-associative source and doesn't require a Creo Parametric install-
ation. (This reader does not support CAD associativity or parameters.)

b. The Workbench Associative Plug-In option requires Creo Parametric to be installed. When you
choose this option, the Creo Parametric tab opens.

i. Enter or browse to the Creo Parametric installation location (for example,C:\Program
Files\PTC\Creo 2.0\Parametric).

ii. Enter or browse to the Creo Parametric start command (for example,C:\Program
Files\PTC\Creo 2.0\Parametric\bin\parametric.bat). Include the complete
path if entering the command manually.

iii. Click Next.

Note

When ANSYS Workbench is installed by an administrative user, the Creo Parametric plug-
in will load for all users of the designated CAD install. However, when multiple Creo
Parametric installations are present on the system, the plug-in should only be configured
for a single installation of Creo Parametric; otherwise unconfiguring the plug-in will
cause load problems for all other installations of the CAD.

5. If you selected NX as one of your CAD products, you will have to choose which NX product to configure:

a. The Reader option specifies the non-associative source and doesn't require an NX installation. (This
reader does not support CAD associativity or parameters.)

b. The Workbench Associative Plug-In option requires NX to be installed. When you choose this option,
the NX tab opens.
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i. Enter or browse to the NX installation location (for example,C:\Program
Files\Siemens\NX 8.5).

ii. Enter or browse to the NX custom directory file path (for example,C:\Documents and
Settings\UserName\Application Data\ANSYS\v162\Unigraphics).

Note

If you are installing as an administrator, this file path will be defined in your
administrator's user space by default and non-administrative users will not be
able to run. Use this setting to specify a new location for the custom directory
file path that is accessible by all users.

iii. Click Next.

6. If you selected Inventor and/or SolidWorks as one of your CAD products, you will have to choose which
Inventor and/or SolidWorks product to configure:

a. The Reader option specifies the non-associative source and doesn't require an Inventor or SolidWorks
installation. (This reader does not support CAD associativity or parameters.)

b. The Workbench Associative Plug-In option requires Inventor or SolidWorks to be installed.

7. If SpaceClaim Engineer is installed, you will have to choose to configure the ANSYS Workbench Plug-
In for either SpaceClaim Direct Modeler or SpaceClaim Engineer. Otherwise you are limited to config-
uring the SpaceClaim Direct Modeler Plug-In.

8. If you selected Teamcenter as one of your CAD products, the Teamcenter tab opens:

a. Enter or browse to the Teamcenter installation location (for example,C:\SIEMENS\Teamcen-
ter2008).

b. Discriminator is a client-defined identifier for a session. For example, ANSYSWBPlugInTC.

c. Choose Next.

9. If you selected Catia V5 as one of your CAD products, you will have the option to choose which CATIA V5
product to configure.

a. Select the Reader option to configure the CATIA V5 standalone reader that does not require an in-
stallation of the CATIA V5 CAD program. (This reader does not support CAD associativity or parameters.)

b. Select the CADNexus/CAPRI CAE Gateway option to configure the CATIA V5 associative reader that
does require an installation of the CATIA V5 CAD program and the CADNexus/CAPRI CAE Gateway
(this geometry interface does support CAD associativity and parameter modifications).

c. Click Next.

10. The CAD Configuration tab opens.
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a. Click the Configure Selected CAD Interfaces button.

b. When the configuration for all products is complete, log entries appear, listing those products that
were successfully configured and those that were not. Address any errors and reconfigure.

c. For more details, click the Display Configuration Log File button to see a detailed log file.

11. When all of your CAD products have been successfully configured, click Exit.

You can review the CAD Configuration Manager log file, CADConfigurationMgr.log, in \ANSYS
Inc.

Important

If you change your source from reader to associative plug-in or vice-versa (Creo Parametric,
NX, SolidWorks, Autodesk Inventor, or Catia V5), you must first unconfigure the existing
source and then configure using the new source.

8.1.1. Unconfiguring

If you need to unconfigure any of your CAD products, follow the steps above, but choose Unconfigure
Selected CAD Interfaces on the CAD Configuration tab.

8.1.2. Running the CAD Configuration Manager in Batch Mode

You can configure ANSYS Geometry Interfaces by supplying the CAD Configuration Manager with
arguments specific to the CAD sources you want to make available. The following table contains a list
of supported arguments.

The command to run the CAD Configuration Manager in batch mode on Windows is:

"<installpath>\commonfiles\CAD\bin\winx64\Ans.CadInt.CADConfigurationUtility.exe" 
     -arguments

CommentValueArgument

Results in any specified CAD sources being
unconfigured. When this flag is absent, the CAD

NoneUNCONFIGURE_SPECIFIED

Configuration Manager will attempt to configure
all designated CAD sources.

Results in all CAD sources being disabled along
with prerequisite libraries.

NoneUNCONFIGURE

Specify Creo Parametric source as either the
associative plug-in or the reader (Spatial, no Creo

NoneEither: PE_CONFIG_WB or
PE_CONFIG_WBSPATIAL

Parametric install required). When the plug-in is
specified, additional arguments PROELOADPOINT
and PROE_START_CMD are required.

Not required with unconfigure operation.Full path to Creo
Parametric

PROELOADPOINT

installation (quotes
required on
Windows).
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CommentValueArgument

Not required with unconfigure operation.Full path to
command used to

PROE_START_CMD

launch Creo
Parametric (quotes
required on
Windows)

Specify NX source as either the associative plug-in
or the reader (Spatial, no NX install required).

NoneEither: UG_CONFIG_WB or
UG_CONFIG_WBSPATIAL

When the plug-in is specified, the argument
UGII_BASE_DIR must also be specified.

This should agree with environment variable
UGII_BASE_DIR. Not required with unconfigure
operation.

Full path to NX
installation

UGII_BASE_DIR

Specify Catia V5 source as either the Reader
(Spatial, no Catia install required) or CAPRI
(CADNexus install required).

NoneEither: CATIA_SPATIAL or
CATIA_CAPRI

Configure/unconfigure Creo Elements/Direct
Modeling.

NoneOSDM_CONFIG

Specify Inventor source as either the associative
plug-in or the reader (Spatial, no Inventor install
required).

NoneEither: INVENTOR_CONFIG or
INVENTOR_CONFIG_WBSPATIAL

Specify SolidWorks source as either the associative
plug-in or the reader (Spatial, no SolidWorks install
required).

NoneEither: SOLIDWORKS_CONFIG
or SW_CONFIG_WBSPATIAL

Configure/unconfigure Solid Edge.NoneSOLIDEDGE_CONFIG

Configure/unconfigure AutoCAD.NoneACAD_CONFIG

Configure/unconfigure Teamcenter; for
configuration requiresTC_ROOT flag.

NoneTEAMCENTER_CONFIG

Not required with unconfiguration operation.Path to Teamcenter
installation.

IMAN_ROOT

Configure/unconfigure JT.NoneJTOPEN_CONFIG

Configure/unconfigure CATIA v4.NoneCATIA4_CONFIG

Note

All arguments require a dash (-) before them in order to be properly recognized by the CAD
Configuration Manager. Arguments' values should not have a dash preceding them.

For example, you can configure Creo Parametric and SolidWorks Geometry Interfaces to ANSYS Workbench
from the command line by using the following:

"<installpath>\commonfiles\CAD\bin\winx64\Ans.CadInt.CADConfigurationUtility.exe" 
-SW_CONFIG -PE_CONFIG_WB -PROELOADPOINT "C:\Program Files\PTC\Creo 2.0\Parametric" 
-PROE_START_CMD "C:\Program Files\PTC\Creo 2.0\Parametric\bin\parametric.bat"

where installpath is the same as the value of environment variable %AWP_ROOT162%, platform
is the value of environment variable %ANSYS_SYSDIR%, and Creo Parametric is installed to C:\Program
Files\PTC\Creo 2.0\Parametric.
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To unconfigure the same CAD Interfaces, the command would be:

"<installpath>\commonfiles\CAD\bin\winx64\Ans.CadInt.CADConfigurationUtility.exe" 
-unconfigure -SW_CONFIG -PE_CONFIG_WB

Although the argument order does not matter, an argument value must immediately follow its argument.

8.1.3. Network Considerations

When Workbench is installed to a network location (made available from a mapped network drive), any
configuration actions will make the selected geometry interfaces available/unavailable only to the user
who is currently logged in. To make changes that apply to all users, the configure/unconfigure action
must be run as an administrator logged into the system hosting the Workbench installation.  Configur-
ation actions performed as an administrator on this server machine will impact all users on all machines
referencing that install, except for users who have overridden the server configuration by configuring
for themselves.

Prior to running the CAD Configuration Manager from a network location, the product configuration
tool must be executed. This process will result in the client system being configured to match the
geometry interface selections on the server.  Products requiring additional information such as interfaces
to Creo Parametric, NX and Teamcenter may fail to configure. This can be remedied either by manually
running CAD Configuration Manager following Product Configuration, or by setting appropriate envir-
onment variables prior to execution of Product Configuration such as UGII_CUSTOM_DIRECTORY_FILE,
PROE_START_CMD150 and TC_ROOT. TC_ROOT can be set to the path of your Teamcenter installation.
Further details regarding environment variables pertaining to Creo Parameteric and NX are offered in
the interface specific help sections below.  For more information on using the Product Configuration
manager, please see Network Server and Product Configuration (p. 31).

For loading associative geometry interfaces into their respective CAD environments, when the Workbench
installation is referenced from a network location:

• A local administrator’s configuration changes will set up associative CAD interfaces to load into the CAD
environment of all local users, when that scope is selected (applicable to AutoCAD, Inventor, SolidWorks,
Solid Edge, Creo Elements/Direct and NX).

• The associative geometry interface for Creo Parametric will load into the CAD environment of all users when
the CAD installation is writable for that administrative user.  Otherwise, it will load only into the CAD envir-
onment of the administrator who is currently logged in, and each additional user must be configured indi-
vidually.

CAD Readers for JT, Creo Parametric, Inventor, NX and Solidworks may not fully unconfigure on a client
of a network installation, even when this action is attempted by a client's administrator. An administrative
user on the server must execute an unconfigure action, using CAD Configuration Manager, in order for
these interfaces to be fully deactivated on the client.

8.1.4. Uninstalling

Warning

Do not proceed with an uninstall for CAD-specific unconfigure actions or you will leave some
ANSYS Workbench products unusable.
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8.1.5. Creo Parametric Configuration

Running the CAD Configuration Manager for Creo Parametric performs the following steps to activate
the Creo Parametric plug-in:

• Sets the environment variable PROE_START_CMD162 to the file used to launch Creo Parametric (for example
C:\Program Files\PTC\Creo 2.0\Parametric\bin\parametric.bat).

• For administrative installations, adds the ANSYS 16.2 entry to the config.pro file located in
<creo_path>\text. An example for Creo Parametric would be:

PROTKDAT C:\Program Files\PTC\Creo 2.0\Common Files\M100\text

An example for Wildfire 5.0 would be:

PROTKDAT C:\Program Files\proeWildfire 5.0\text

• Updates the WBPlugInPE.dat file referenced in the config.pro file, so that it contains information for
loading the WorkBench Plug-In and the ANSYS Connection product.

• Registers the Plug-In file WBPlugInPECOM.dll (Creo Parametric) or DSPlugInPEWF5COM.dll (Wildfire
5.0) referenced in the WBPlugInPE.dat file.

• When Workbench is installed on a network location and the local administrator has write permissions to
<creo_path>\text, a version-specific WBPlugInPE162.dat file will be created and placed in that
folder.  However, when <creo_path>\text is unwriteable, both the config.pro and the WBPlugIn-
PE162.dat will be placed in either %HOME% or %HOMEDRIVE%%HOMEPATH%.

If you do not have write access to your ANSYS Workbench installation, you may encounter the following
error when attempting to import Creo Parametric models without an active CAD session:

No write access, please choose another startup directory for trail file
creation.

To prevent this issue, add the following line to your config.pro file:

trail_dir $TEMP

WBPlugInPE.dat File Contents The WBPlugInPE.dat file should look like this example:

NAME WB162PluginProWF
EXEC_FILE E:\Program Files\ANSYS Inc\V162\AISOL\CADIntegration\ProE\
     winx64\WBPlugInPECOM.dll
TEXT_DIR E:\Program Files\ANSYS Inc\V162\AISOL\CADIntegration\ProE\
     ProEPages\Language\<locale>
STARTUP dll
delay_start FALSE
allow_stop TRUE
unicode_encoding FALSE
REVISION ProEWildfire
END

NAME ac4pro162dll
exec_path E:\Program Files\ANSYS Inc\V162\ANSYS\ac4\bin\pro\winx64\ac4pro.exe
text_path E:\Program Files\ANSYS Inc\V162\ANSYS\ac4\data\pro\text
STARTUP dll
delay_start FALSE
allow_stop TRUE
unicode_encoding FALSE
unicode_encoding FALSE
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revision 24.0
end

Note

When configuring the plug-in to run with Wildfire 5.0, the reference to WBPlugInPECOM.dll
will instead be DSPlugInPEWF5COM.dll and ac4pro.exe should be ac4pro_wf5.exe.

<locale> should be "en-us" for English, "de" for German, "fr" for French, or "ja" for Japanese.

Do not delete any of these lines. If you modify this file, do NOT enter a carriage return after the END
line. The file may be customized with other information. If these lines are deleted, or if the WBPlugIn-
PE.dat file is not present in any of the directories in the search path, Creo Parametric will not load
ANSYS-related CAD interfaces. You should typically never have to edit these files for path information
contained within them. Paths are determined by environment variable settings, which are set automat-
ically during installation. If you encounter problems when attempting to run Creo Parametric, use the
CAD Configuration Manager to reconfigure rather than attempting to edit files directly.

Following an update of an existing Creo Parametric 2.0 or 3.0 installation to a different maintenance
release (for example upgrading from datecode F000 to M010), the ANSYS Workbench Associative Plug-
In will no longer be configured. To reactivate your plug-in, follow the steps described in Using the CAD
Configuration Manager (p. 53). This situation does not apply to Pro/ENGINEER Wildfire 5.0, or Creo
Elements/Pro 5.0.

In order for CAD Configuration Manager to successfully perform configuration of the Creo Parametric
Associative Geometry Interface it is required that the Windows Operating System's decimal separator
be the same symbol when running configuration as it was when the original Creo Parametric installation
was performed.

8.1.5.1. Configuring the Connection for Creo Parametric

All Creo Parametric users must have copies of the WBPlugInPE.dat file and the config.anscon.162
(connection for Creo Parametric) files. The config.anscon.162 file is placed in the Program
Files\ANSYS Inc\V162\ansys\ac4\data\winx64 directory. config.anscon.162 must be
copied into the user's working directory at the time Creo Parametric is started. The WBPlugInPE.dat
file is placed in the Program Files\ANSYS Inc\V162\AISOL\CADIntegration\%AN-
SYS_PROEWF_VER%\ProEPages\config directory. This file defines the name of the executable,
the path to the executable, the path to the message file, and the current revision of Creo Parametric.

Note

If the ANSGeom menu in Creo Parametric does not appear correctly, copy the con-
fig.anscon.162 file into your working directory and restart Creo Parametric.

8.1.5.1.1. The WBPlugInPE.dat File and config.pro File

Creo Parametric uses the WBPlugInPE.dat file to locate related executables such as the connection
for Creo Parametric.

Mechanical APDL/ANSYS Workbench also requires a config.pro file.
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• The config.pro file resides in <path-to-proe>\text for any Pro/ENGINEER Wildfire release and
<path-to-creo-parametric>\..\Common Files\<Creo Ship Code>\text for Creo Parametric.
The Creo Ship Code is a three digit number preceded by a single letter. The ship code is specified in
the Creo Parametric installation log, which can be found in <path-to-creo-parametric>\unin-
stall\instlog.txt for version 1.0, or in <path-to-creo-parametric>\bin\pim\xml\creo-
base.xml for version 2.0. For version 2.0, in the cases that the crebase.xml file is missing, the ship code
can be determined by looking in the Windows Registry using regedit. That value is located in either
HKLM\Software\PTC\Creo Parametric\2.0\Shipcode or SOFTWARE\Wow6432Node\PTC\Creo Paramet-
ric\2.0\Shipcode.

The config.pro file contains a PROTKDAT line that points to the WBPlugInPE.dat file. This file is
generated either during the product install or by running the CAD Configuration Manager to configure
the Mechanical APDL /ANSYS Workbench products for Creo Parametric.

The <proe_platform> variable is the name that Creo Parametric gives to its platform directories:

WBPlugInPECOM

Creo Parametric
Platform

ANSYS Platform
<platform>

Hardware
Platform

<proe_plat-
form>

x86e_win64winx64Win 7 and Win
8.1 x64

8.1.5.1.2. The config.pro File

A typical config.pro file might look like the following example. This example has an entry for ANSYS
Workbench. You may have other Creo Parametric specific customizations.

PROTKDAT E:\Program Files\ANSYS Inc\V162\AISOL\CADIntegration\$ANSYS_PROEWF_VER\
     ProEPages\config\WBPlugInPE.dat

8.1.5.1.3. The config.anscon.162 File

Users who launch Mechanical APDL from Creo Parametric will need the information from the con-
fig.anscon.162 file. This file is installed for all users in the \ac4\data\winx64 subdirectory. You
typically do not need to edit this file. Here is a sample config.anscon.162 file:

ANSYS_CMD %AWP_ROOT162%\ANSYS\bin\%ANSYS_SYSDIR%\ansys162.exe
ANSYS_GRAPHIC_DEVICE WIN32
ANSYS_SOLVER Sparse**
ANSYS_SELECTED_LAYERS 1-256**
ANSYS_GEOMETRY_TYPE Solids Only**
ANSYS_NEUTRAL_FORMAT Yes**
ANSYS_PRODUCT_NAME ANE3FL

**These variables are not supported by Creo Parametric and are ignored by Creo Parametric.

See Setting ANSYS Configuration Parameters in the Connection User's Guide for more information about
the config.anscon.162 file.
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8.1.5.2. Creo Parametric Environment Variables

Most environment variables are set during product installation. In general, you will not need to reset
these variables. Check the manuals for the individual CAD products for information about environment
variables and their settings.

PROE_START_CMD162
Specifies the name of the .bat file which launches Creo Parametric on the system. The path to the execut-
able should be already set if the Creo Parametric installation path has been defined for the PATH environ-
ment setting.

PROE_START_CMD162 Default = C:\Program Files\PTC\Creo 2.0\Paramet-
ric\bin\parametric.bat

8.1.6. NX Configuration

Running the CAD Configuration Manager for NX performs the following steps to activate the NX plug-
in:

• If not already existing, sets the environment variable UGII_CUSTOM_DIRECTORY_FILE to %APPDATA%\AN-
SYS\v162\Unigraphics\custom_dirs.dat.

• If not already present, adds an entry to the custom_dirs.dat file specifying the location of the Plug-In,
e.g.,C:\Program Files\ANSYS Inc\V162\AISOL\CADIntegration\UnigraphicsNX\winx64.

• Registers the Plug-In file (DSPlugInUGCOM.dll). For the previous example, these files would be located
in C:\Program Files\ANSYS Inc\V162\AISOL\CADIntegration\Unigraphic-
sNX\winx64\startup.

Specific to Windows 8.1, when NX 10 is configured for the associative Workbench reader during the
end of the install, the CAD Configuration Manager incorrectly shows an error that says "Configure Failed
- Registration Error". However the configuration is still successful, and this error message can be ignored.

8.1.6.1. Configuring the Connection for NX

User-Defined Environment Variables You will need to have the following environment variable set
if you will be running the connection for NX product from inside NX.

UGII_VENDOR_DIR for Mechanical APDL
This environment variable is not set during the installation process and can only be set in a user's start-up
file or at command level before running NX. This environment variable defines the ANSYS menu for NX.
You must set this environment variable if you will be running the connection for NX product from inside
NX. This environment variable tells NX where to find the ANSYS program, for example:C:\Program
Files\ANSYS Inc\V162\ANSYS\ac4\bin\ug50\winx64.

UGII_BASE_DIR  and UGII_ROOT_DIR
The environment variables UGII_BASE_DIR and UGII_ROOT_DIR must be defined for proper operation
of NX and the ANSYS Workbench Plug-In to NX. These environment variables are typically created by the
NX installer; however, in rare cases, you may have to create/update these two variables. In these situations,
the NX Installation Location field will be left blank within the CAD Configuration Manager's NX tab.

When multiple NX versions are installed on a system, the UGII_BASE_DIR environment variable
must be set to the install path of the NX version to be launched, prior to starting that version of
the CAD.  Otherwise errors will be encountered during CAD startup and the plug-in will not load.
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For example, if switching from NX 8.5 to run NX 9.0, you must update UGII_BASE_DIR to the NX
9.0 path before starting NX 9.0. Similarly, the UGII_ROOT_DIR environment variable must be set to
the ugii subdirectory in the install path of the NX version to be launched.

8.1.6.2. Configuring for Teamcenter

Running the CAD Configuration Manager for Teamcenter performs the following step to activate the
Teamcenter plug-in:

• When Teamcenter Unified is detected, the environment variable TC_ROOT is set to the Teamcenter Unified
installation path.

8.2. Configuring CADNexus/CAPRI CAE Gateway for CATIA V5

The CADNexus/CAPRI CAE Gateway for CATIA V5 product is available for ANSYS Workbench. The ANSYS
Workbench-specific portions are included in the installation. However, to run this product, you must
complete the configuration as follows:

1. Install ANSYS Workbench according to the instructions in this guide.

2. Install CATIA V5 and LUM licensing (requires a CATIAV5 license key MD2, HD2 or ME2).

3. From the ANSYS, Inc. Customer Portal, download the CADNexus/CAPRI CAE Gateway for CATIA V5 for
your platform to a temporary folder. (Do not download to a folder containing blank spaces in the folder
name, e.g., Program Files). Follow the download procedures described in Downloading the Installation
Files (p. 16).

4. Extract the contents of the zip file using your standard zip utility.

5. Install CADNexus/CAPRI CAE Gateway for CATIA V5 using the appropriate exe for your platform.

6. Follow the instructions on the CAPRI installation screens to complete the installation. When specifying
the component to install, you will need to select the desired CatiaV5 release under CAPRI CAD Applications.
When asked if CAPRI should set the environment variables, click Yes.

7. Run the CAD Configuration Manager and select the Catia V5: CADNexus/CAPRI CAE Gateway option
to complete the configuration as described in Using the CAD Configuration Manager (p. 53).

Note

Using the CAD Configuration Manager to set up the CADNexus/CAPRI CAE Gateway
does not require administrative rights, although installing that product (step 5) requires
these rights. However, if you want to reconfigure to use the ANSYS Workbench Reader
for Catia V5, administrative rights are required.

If you want to revert to the standard CATIA V5 interface, run the CAD Configuration Manager and
select the Catia V5: Standard Interface option to complete the configuration as described in Using
the CAD Configuration Manager (p. 53).

You cannot run the standard CATIA V5 interface simultaneously with the CADNexus/CAPRI CAE Gateway
for CATIA V5 interface.
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8.3. Configuring AutoCAD

Running the CAD Configuration Manager for AutoCAD performs the following steps to active the plug-
in:

1. Creates the folders %PROGRAMDATA%\AnsysWB.bundle and %PROGRAMDATA%\Autodesk\Application-
Plugins\AnsysWB.bundle\Contents\v162\Winx64\AutoCAD

2. Copies the following folders from the Workbench installation into the bundle's AutoCAD sub-folders:

• All files within <ANSYS 16.0 Install Path>\aisol\CADIntegration\DWG\winx64 are copied to %PROGRAM-
DATA%\ApplicationPlugins\AnsysWB.bundle\Contents\v162\winx64\AutoCAD\2013

• All files within <ANSYS 16.0 Install Path>\aisol\CADIntegration\DWG\images are copied to %PROGRAM-
DATA%\Autodesk\ApplicationPlugins\AnsysWB.bundle\Contents\v162\winx64\AutoCAD\Resources

• All folders within <ANSYS 16.0 Install Path>aisol\CADIntegration\DWG\Language are copied to %PRO-
GRAMDATA%\Autodesk\ApplicationPlugins\AnsysWB.bundle\Contents\v162\winx64\AutoCAD\Re-
sources\Language

3. Finally a %PROGRAMDATA%\Autodesk\ApplicationPlugins\AnsysWB.bundle\PackageContents.XML file is
created with the following contents:

<?xml version="1.0" encoding="utf-8"?> 

<ApplicationPackage ProductCode="{6C6B872A-2ECF-4272-B7B7-1CA69B1EAD08}" HelpFile="./Contents/v162/

Winx64/AutoCAD/Resources/cadAutoCAD.html" Icon="./Contents/v162/Winx64/AutoCAD/Resources/ansys70.bmp" 

Description="ANSYS Workbench Geometry Interface 16.2" AppVersion="16.2" Name="AnsysWB162

" ProductType="Application" SchemaVersion="1.0" AutodeskProduct="AutoCAD" FriendlyVersion="15.0

" SupportedLocales="Enu" OnlineDocumentation="www.ansys.com

" Author="ANSYS, Inc." UpgradeCode="{12D6EF98-CEE6-431E-B699-DE9DE4F32B7E}">  

 <CompanyDetails Name="ANSYS, Inc." Email=" " Url="www.ansys.com" Phone=" " />   

<RuntimeRequirements SeriesMax="R19.1" SeriesMin="R19.0" Platform="AutoCAD" OS="Win64" />   

<Components Description="64bit Component">     

<RuntimeRequirements SeriesMax="R19.1" SeriesMin="R19.0" Platform="AutoCAD" OS="Win64" />     

<ComponentEntry AppName="WB150PlugInDWG" ModuleNameWin64="./Contents/v162/Winx64/AutoCAD/2013/

WB150PlugInDWG.arx" AppDescription="Windows 64bit support" LoadOnCommandInvocation="True"

 LoadOnRequest="True"> 

<Commands GroupName="ANSYS_Workbench_Geometry_Interface">         

<Command Local="WB150STARTWB" Global="WB150STARTWB" />         

<Command Local="WB150STARTASIM" Global="WB150STARTASIM" />        

 <Command Local="WB150HELP" Global="WB150HELP" />        

 <Command Local="WB150ABOUT" Global="WB150ABOUT" />       

</Commands>     

</ComponentEntry>     

<ComponentEntry AppName="AnsysWB150" ModuleName="./Contents/v162/Winx64/

AutoCAD/Resources/Language/
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en-us/Workbench150.cuix" />  

 </Components> 

</ApplicationPackage>
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Chapter 9: Uninstalling the Software

Use this process to uninstall any ANSYS, Inc. product that was installed using the Unified Installation
process.

Note to CFX Users The provided uninstall tool cannot uninstall MPI services. If you have CFX products
installed that you are uninstalling, you must stop the MPI services before continuing with the uninstall:

1. As an administrator, go to the Run window and type Services.msc.

2. Search for "IBM Platform MPI Remote Launch" and if found, click Stop.

3. Search for "Intel(R) MPI Library Process Manager" and if found, click Stop.

4. Continue with the uninstallation procedure, below.

Uninstall Procedure for All Users All users should use the following procedure to uninstall ANSYS,
Inc. products.

1. Close down all applications that are currently running.

2. From Windows 7, select Start > All Programs > ANSYS 16.2 > Uninstall 16.2. From Windows 8.1, right-
click the Start Screen> All apps> ANSYS 16.2> Uninstall 16.2. You must uninstall with the same or
higher privileges than were used to install the product, and we strongly recommend uninstalling as the
same user who installed the product originally.

3. Select the product(s) to be uninstalled and unconfigured and click Uninstall Selected Item(s). Not all
products and product components may be listed individually.

4. You will be asked to save all data and close all Windows applications before continuing. Click OK.

5. You will be asked if you are sure you want to uninstall the selected products. Click Yes.

6. A message appears indicating that the uninstallation is complete. Click OK.

Note

After all the desired products are uninstalled, you are presented with a message
stating that any files or directories that were not recognized by our uninstall program
remain. These remaining files typically include such things as .udf files, user custom-
ized documentation, and various routines.  If these files are no longer required,
please remove them manually.

CFD-Post CFD-Post can be installed as a standalone product; however, as a standalone product, it is
also automatically installed with Fluent, Polyflow, and Icepak. To uninstall CFD-Post, you must uninstall
all of the above products that you have installed.
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• If you choose to uninstall standalone CFD-Post without uninstalling the other products, the uninstall program
will not uninstall CFD-Post.

• If you choose to uninstall all of the other products that include standalone CFD-Post but you do not select
CFD-Post, then CFD-Post will not be removed.

Individual product directories may not be removed if they contain components that are shared with
other products that have not been uninstalled. However, the uninstalled product will no longer run.

In the case of a platform (file server) installation, the uninstall will remove the selected product(s) from
all of the Windows platforms.

This procedure removes the specified ANSYS, Inc. program from your system but will not remove the
ANSYS licensing components. Follow the steps in Uninstalling Licensing Components (p. 68) to uninstall
the licensing components.

9.1. Uninstalling Licensing Components

Before proceeding with the following steps to remove the ANSYS licensing components from your
system, make certain that there are no ANSYS, Inc. products on this machine or any other machines on
the network that rely on these ANSYS licensing components.

License Servers  Follow these steps on a license server machine:

1. Stop the ANSYS, Inc. License Manager via the ANSYS License Management Center.

2. Uninstall the ANSYS, Inc. License Manager service. You must use the following command to do so:

"C:\Program Files\ANSYS Inc\Shared Files\Licensing\<platform>\ansysli_server" 
     -k uninstall

3. Delete the Licensing subdirectory.

4. Remove the ANSYS, Inc. License Manager folder from the Start menu.

5. Remove the ANSYSLIC_DIR and the ANSYSLIC_SYSDIR environment variables, if set.

Clients Follow these steps on client machines:

1. Delete the Licensing subdirectory.

2. Remove the ANSYS 16.2> ANSYS Client Licensing folder from the Start menu or from the Apps screen.
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Chapter 10: Troubleshooting

10.1. Installation Troubleshooting

This section lists problems and error messages that you may encounter while installing and/or running
ANSYS, Inc. products. After each situation description or error message is the user action required to
correct the problem.

You can also find answers to commonly-asked questions on our customer portal. After you log in to
the customer portal, select Knowledge Resources> Solutions.

For information on licensing-related errors, see the Troubleshooting section of the ANSYS, Inc. Licensing
Guide.

10.1.1. Using ANSLIC_ADMIN to Gather Diagnostic Information

There are situations which require licensing-related information to be gathered for diagnostic and
troubleshooting purposes. At times it may be necessary to provide this information to technical support.

The client-related diagnostic information can be gathered by using the Client ANSLIC_ADMIN utility.
For more information, see, Gather Client Diagnostic Information.

The server-related diagnostic information can be gathered by using ANSYS License Management
Center or by using the standalone gatherdiagnostics script. For more information, see, Gathering
Diagnostic Information.

You can also use the AnsysInstallationDiagnostics.exe, in the \v162\instutil directory,
for additional installation diagnostics. This tool is helpful to diagnose installation and runtime issues.
One or more log files will be generated either at the same location as the tool or in your temporary
directory, depending on directory permissions. The log files are intended to help ANSYS, Inc. technical
support personnel expedite any technical issues. It would be useful to have the files ready to provide
before contacting Technical Support.

10.1.2. Uninstall Gives Access Denied Error Message

If you run the uninstall utility as a non-administrative user, you may get access denied error messages
when removing product components. Run the uninstall as an administrative user, and close all applica-
tions before running the uninstall.

10.1.3. Uninstall on a Windows 7 or Windows 8.1 System Gives Compatibility
Error Message

If you uninstall an ANSYS, Inc. product on a Windows 7 or Windows 8.1 system using the ANSYS, Inc.
Uninstall utility, you may see the following error message:

This program might not have installed correctly.
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If this program didn't install correctly, try reinstalling using settings that are compatible with this
version of Windows.

This message is caused by the Windows Program Compatibility Assistant and can safely be ignored.
Click Cancel and continue with the uninstall.

10.1.4. A .chm File Does Not Display Properly Across a Network

Help system .chm files may not display topics correctly when you try to use a Universal Naming Con-
vention (UNC) path to open the file on a network shared folder, typical with a Network Configuration
install. This is a known issue with security update 896358, security update 840315, or Microsoft Windows
Server 2003 Service Pack 1 (SP1). Please go to http://support.microsoft.com/kb/896358 and http://sup-
port.microsoft.com/kb/896054 for more information on this problem and Microsoft's recommended fix.

If you are running ICEM CFD over the network and you have applied this security update, you may not
be able to access ICEM CFD Help using the Help menu. To access ICEM CFD Help, navigate to common-
files\help\en-us in the installation directory on the server machine and copy the file icem-
cfd_help.chm to your local machine. Double-click the local copy to view the help.

10.1.5. Products Crash with an Application Error

On Windows Server 2008 systems, ANSYS applications may crash with an application error if the DEP
(Data Execution Prevention) flag is set. To check your DEP setting, right mouse click on My Computer,
and select Properties. Select the Advanced tab, and under Performance, click Settings. Then select
the Data Execution Prevention tab.

If DEP is set, you will need to add ANSYS to the list of exceptions. For more information on DEP and
how to change the settings, see http://support.microsoft.com/kb/875351.

10.1.6. Product Installation Does Not Create Start Menu Item for ANSYS and
CAD Plugins Do Not Work

On a Windows 7 or Windows 8.1 system, if you install ANSYS, Inc. products but do not see a Start
Menu/Apps item and your CAD plugins do not work, the TEMP environment variable may be pointing
to an inaccessible location. For example, it may point to a location such as %USERPROFILE%\Local
Settings\Temp. As a result, the product installation could end without configuring the product
correctly. You should ensure that the TEMP variable points to a valid location, such as %USERPRO-
FILE%\AppData\Local\Temp.

10.1.7. Product Installation Displays Security Warning Dialogs or Silent Product
Installation Hangs on a Network Install

If you see a security warning dialog box during a GUI installation/product configuration, or if your in-
stallation hangs during a silent installation, you may need to modify your security settings. Set the
machine you are installing from as a trusted site and allow launching of unsafe applications so that the
prerequisite installation can complete. Then re-run the installation. Contact your system administrator
or refer to your operating system documentation for details on modifying security settings.

Alternatively, you can run the prerequisite check to verify that you have all the necessary prerequisites.
If necessary, install any prerequisites and rerun the installation:

1. Run PreReqCheck.exe from the top level directory.
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2. Install any missing prerequisites by running InstallPreReqs.exe from the top level directory as an
administrator.

3. When the prerequisites have finished installing, run the installation as you normally would (GUI or silently).

10.1.8. System-related Error Messages

***Error, ANSYS162_DIR environment variable is not set. This is a fatal error – exiting.

This message indicates that the ANSYS162_DIR environment variable was not set where necessary
for licensing. This environment variable should be set to the installation directory.

Unexpected error: Request for the permission of type ... failed.

If you encounter this type of message on a server configuration, you may need to set the machine
as a trusted site. On a Windows 7 or Windows 8.1 machine, in the Control Panel, select Network
and Internet, select Internet Options, and select Security. Click on Trusted Sites and click Sites.
Add the machine as file://servername.

10.1.9. CasPol Error Messages

ERROR: Not enough arguments, no permission set specified

If you are configuring to a server with spaces in the path and get this error, then you must put
quotes around your server specification as shown in the following example:

C:\Users\>C:\Windows\Microsoft.NET\Framework\v2.0.50727\CasPol.exe -m -a
g 1.2 -url file://"\\machineabc\ANSYS Inc\*" FullTrust

10.1.10. Configuring NX 10 on Windows 8.1 Displays an Error

Specific to Windows 8.1, when NX 10 is configured for the associative Workbench reader during the
end of the install, the CAD Configuration Manager incorrectly shows an error that says "Configure Failed
- Registration Error". However the configuration is still successful, and this error message can be ignored.

10.2. Installation Troubleshooting - Mechanical APDL and ANSYS Work-
bench Products

The items listed below apply only to the Mechanical APDL and/or ANSYS Workbench products.

10.2.1. The Mechanical APDL Launcher is Excessively Slow to Start

If the Mechanical APDL launcher takes an excessively long time to startup (Windows only), make sure
the hostnames in the ansyslmd.ini file and in the ANSYSLMD_LICENSE_FILE and the ANSYSLI_SERV-
ERS environment variables are typed correctly and that the hosts specified by the hostnames exist.
Replacing hostnames with IP addresses may improve the speed as well. Also verify that the port number
is correct.

10.2.2. Display Problems on Windows

This situation applies only to Windows systems running Mechanical APDL.

Windows includes a function called Aero that may cause Mechanical APDL graphing or plotting problems
in 3-D mode on some systems. If this problem occurs, disable the Windows Aero theme in Windows 7
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when running Mechanical APDL. If you are using Windows 8.1, please follow the steps below to correct
this issue.

Disabling Aero in Windows 8.1

1. Open the Windows Control Panel.

2. Click Ease of Access.

3. Click Optimize Visual Display.

The Make the computer easier to see window opens. Please note that you can access this window
in a number of ways.

4. Enable the Turn off all unnecessary animations (when possible) option.

5. Click Ok.

6. Close the Windows Control Panel.

10.2.3. ANS_ADMIN Error Messages

Grayed out options

If certain options are grayed out, your account may not have the necessary system administrator
privileges necessary to run those options.

10.2.4. Mechanical APDL Product Launcher Error Messages

Some of the more common error messages follow. See the ANSYS, Inc. Licensing Guide for licensing-
related launcher messages.

***Cannot create required <profile> file. Therefore, cannot write to profile information during
this launcher session.

If you see this error, you cannot add or modify profile information during this launcher session.
Verify that you have write access to the directory and restart the launcher session. Typically, this
directory is C:\Documents and Settings\<user name>\Application Data\AN-
SYS\v162\launcher on Windows or ~/.ansys/v162/launcher/ on UNIX.

***No ANSYS product installations found.

Verify your Mechanical APDL product installation. If the desired product was not installed, install it.

10.2.5. Distributed Mechanical APDL IBM Platform MPI Error Messages

You may encounter the following message when setting up IBM Platform MPI or running Distributed
ANSYS using IBM Platform MPI.

Error executing Mechanical APDL. Refer to System-related Error Messages in the Mechanical APDL
online help. If this was a Distributed Mechanical APDL job, verify that your MPI software is installed
correctly, check your environment settings, or check for an invalid command line option.

You may see this error if you did not correctly run the set password bat file. Verify that you completed
this item according to the IBM Platform MPI installation readme instructions.
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You may also see this error if ANSYS Inc\v162\ansys\bin\<winx64> is not in your PATH.

If you need more detailed debugging information, use the following:

1. Open a Command Prompt window and set the following:

SET ANS_SEE_RUN=TRUE
SET ANS_CMD_NODIAG=TRUE

2. Run the following command line:ansys162 -b -dis -i myinput.inp -o myoutput.out.

10.2.6. ANSYS Workbench Products Troubleshooting

This section lists problems and error messages that you may encounter while installing and/or running
ANSYS Workbench. After each situation description or error message is the user action required to
correct the problem. Always try the suggested user action before contacting your technical support
representative.

Problem Situations

CAD System Plug-In Menus Do Not Appear for NX or Creo Parametric ANSYS Workbench on
Windows platforms will append its information to an existing customization file for NX and/or Creo
Parametric. If no customization file exists, ANSYS Workbench will create a file. For NX, ANSYS Workbench
looks for the custom_dirs.dat file in the directory specified via the UGII_CUSTOM_DIRECTORY_FILE
environment variable. For Creo Parametric, ANSYS Workbench looks for the config.pro file in the
%HOMEDRIVE%%HOMEPATH% directory. In addition, during setup of the Creo Parametric Geometry In-
terface, ANSYS Workbench will also append its information to the config.pro file located in the Creo
Parametric installation path, under the \text directory (e.g., Proewildfire2\text\config.pro).

If ANSYS Workbench encounters a read-only file, it will not be able to write the necessary information
to the file. In this case, you will need to revise the permissions on the file and manually add the appro-
priate ANSYS Workbench-specific information in order for the ANSYS menu to appear in NX or Creo
Parametric.

Script Errors When Running ANSYS Workbench If you encounter script errors such as "Error: Unable
to create object microsoft.XMLDOM," you may need to install the latest version of Microsoft's MSXML.
Please visit Microsoft's web site at http://www.microsoft.com/downloads/details.aspx?FamilyID=993c0bcf-
3bcf-4009-be21-27e85e1857b1&DisplayLang=en for more information on downloading and installing
MSXML.

ANSYS Workbench Error Messages

***Unable to connect to Solver Manager.

Another application might be using the Solver Manager port (10002 by default). Try changing the
port number by editing the Ansys.SolverManager.exe.config file located in the installation
directory at \AISOL\Bin\<platform>.

If you are getting the "Unable to connect to Solver Manager" error message or are having difficulty
launching other applications/editors, it is also possible that the Windows hosts file has been corrupted.
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Please make sure that localhost is specified in the Windows <os drive>:\Windows\sys-
tem32\drivers\etc\hosts file.

10.3. Installation Troubleshooting - ANSYS CFX

The items listed below apply only to the ANSYS CFX products.

10.3.1. TurboGrid Mouse Behavior Problems

Depending on the graphics card and driver version, you may experience problems with the accuracy
of mouse clicks in the 3D Viewer. For example, you may try to insert a control point at a given location
by using the mouse, but the control point appears at a location far from where you clicked the mouse.
If you experience such problems, try lowering the hardware acceleration setting of your graphics card.

10.4. Contacting Technical Support

Technical Support for ANSYS, Inc. products is provided either by ANSYS, Inc. directly or by one of our
certified ANSYS Support Providers. Please check with the ANSYS Support Coordinator (ASC) at your
company to determine who provides support for your company, or go to www.ansys.com and select
Contacts> Contacts and Locations.

If your support is provided by ANSYS, Inc. directly, Technical Support can be accessed quickly and effi-
ciently from the ANSYS Customer Portal, which is available from the ANSYS Website (www.ansys.com)
under Support > Customer Portal. The direct URL is: support.ansys.com.

One of the many useful features of the Customer Portal is the Knowledge Resources Search, which can
be found on the Home page of the Customer Portal. To use this feature, enter relevant text (error
message, etc.) in the Knowledge Resources Search box and click the magnifying glass icon. These
Knowledge Resources provide solutions and guidance on how to resolve installation and licensing issues
quickly.

NORTH AMERICA

All ANSYS Products except Esterel, Apache and Reaction Design products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Toll-Free Telephone: 1.800.711.7199 (Please have your Customer or Contact ID ready.)

Support for University customers is provided only through the ANSYS Customer Portal.

GERMANY

ANSYS Mechanical Products

Telephone: +49 (0) 8092 7005-55 (CADFEM)

Email: support@cadfem.de

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

National Toll-Free Telephone: (Please have your Customer or Contact ID ready.)

German language: 0800 181 8499

English language: 0800 181 1565

Austria: 0800 297 835
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Switzerland: 0800 546 318

International Telephone: (Please have your Customer or Contact ID ready.)

German language: +49 6151 152 9981

English language: +49 6151 152 9982

Email: support-germany@ansys.com

UNITED KINGDOM

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Telephone: Please have your Customer or Contact ID ready.

UK: 0800 048 0462

Republic of Ireland: 1800 065 6642

Outside UK: +44 1235 420130

Email: support-uk@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.

JAPAN

Mechanical Products

Telephone: +81-3-5324-8333

Email:

Mechanical: japan-ansys-support@ansys.com

Fluids Products

Telephone: +81-3-5324-7305

Email:

Fluent: japan-fluent-support@ansys.com;

CFX: japan-cfx-support@ansys.com;

Polyflow: japan-polyflow-support@ansys.com;

Icepak

Telephone: +81-3-5324-7444

Email: japan-icepak-support@ansys.com

Licensing and Installation

Email: japan-license-support@ansys.com

INDIA

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Telephone: +91 1 800 209 3475 (toll free) or +91 20 6654 3000 (toll) (Please have your Customer or
Contact ID ready.)

Support for University customers is provided only through the ANSYS Customer Portal.
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FRANCE

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Toll-Free Telephone: +33 (0) 800 919 225 Toll Number: +33 (0) 170 489 087 (Please have your Customer
or Contact ID ready.)

Email: support-france@ansys.com

BELGIUM

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Telephone: +32 (0) 10 45 28 61

Email: support-belgium@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.

SWEDEN

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Telephone: +46 (0) 10 516 49 00

Email: support-sweden@ansys.com

SPAIN and PORTUGAL

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Telephone: +34 900 933 407 (Spain), +351 800 880 513 (Portugal)

Email: support-spain@ansys.com, support-portugal@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.

ITALY

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Telephone: +39 02 89013378

Email: support-italy@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.
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Chapter 11: Applications Included with Each Product

The following table displays which ANSYS, Inc. applications are included with each of the product in-
stallation options.

What is Included?Product Install Option

ANSYS, Inc. Products

ANSYS Structural Mechanics

Workbench [1], Mechanical APDLANSYS Mechanical Products

Workbench [1], Mechanical APDL
User-Programmable Feature

ANSYS Customization Files

ANSYS Explicit Dynamics

Workbench [1], AutodynANSYS Autodyn

Workbench [1], ANSYS AIMANSYS LS-DYNA

Workbench [1], ANSYS AIMANSYS AIM

ANSYS Fluid Dynamics

Workbench[ 1], CFX, CFD-PostANSYS CFX (includes ANSYS
CFD-Post)

Workbench [1], Fluent, CFD-PostANSYS Fluent (includes ANSYS
CFD-Post)

Workbench [1], TurboGridANSYS TurboGrid

Workbench [1], CFD-Post, PolyflowANSYS Polyflow (includes
ANSYS CFD-Post)

Workbench [1], CFD-PostANSYS CFD-Post only

Workbench [1], ICEM CFDANSYS ICEM CFD

ANSYS Offshore

Workbench [1], AqwaANSYS Aqwa

ANSYS Additional Tools

ACP OnlyANSYS Composite PrepPost

CFD-Post, IcepakANSYS Icepak (includes ANSYS
CFD-Post)

Remote Solve ManagerANSYS Remote Solve Manager
Stand Alone Services

ANSYS PDM Interface

TeamCenter Integration for NXTeamCenter Engineering

ANSYS Geometry Interfaces

Geometry Interface for AutoCADAutoCAD

Geometry Interface for ACISACIS
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What is Included?Product Install Option

Geometry Interface for Catia,
Version 4

Catia, Version 4

Geometry Interface for Catia,
Version 5

Catia, Version 5

Geometry Interface for Catia,
Version 6

Catia, Version 6

Geometry Interface for Creo
Elements/Direct Modeling

Creo Elements/Direct Modeling

Geometry Interface for InventorInventor

Geometry Interface for JTOpenJTOpen

Geometry Interface for NXNX

Geometry Interface for ParasolidParasolid

Geometry Interface for Creo
Parametric (formerly Pro/ENGINEER)

Creo Parametric (formerly
Pro/ENGINEER)

Geometry Interface for Solid EdgeSolid Edge

Geometry Interface for SolidWorksSolidWorks

1. Workbench includes the Workbench Framework, DesignModeler, DesignXplorer, SpaceClaim Direct
Modeler, SpaceClaim Catia V5 Interface and Remote Solve Manager.
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